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Installing PowerPath
This chapter contains the following sections:

Topics:

• Before installing PowerPath
• Installation procedures
• After installing PowerPath
• Adding features to an existing installation
• Installing a PowerPath Service Pack for Windows
• Install a PowerPath patch for Windows
• Unsupported installation changes

Before installing PowerPath
The sequence of steps to configure a storage system and install PowerPath or PowerPath/VE for Windows Hyper-V on a host
depends on the storage system you use.

NOTE: Throughout this document, all references to PowerPath refer to PowerPath and PowerPath/VE for Windows

Hyper-V, unless otherwise noted. PowerPath/VE for Windows Hyper-V provides the same multipathing functionality as

PowerPath for Windows in non-virtual environments, and it supports Migration Enabler.

NOTE: In Windows server 2016, the PowerPath 6.2 patch 01 or later installer now enforces two restarts, when MPIO is

not installed before the PowerPath installation. In Windows 2016, the MPIO needs a restart for its configuration. PowerPath

installation can be done only after the MPIO configuration, hence two restarts are required.

NOTE: In Windows 2008 R2, Windows 2012 and Windows 2012 R2, Install the Windows 10 Universal CRT Update for Visual

Studio 2017. The Windows 10 Universal CRT is a Windows operating system component that enables CRT functionality

on the Windows operating system. This update enables Windows desktop applications that depend on the Windows 10

Universal CRT release to run on earlier Windows operating systems. You can download this update from Microsoft Support

NOTE: PowerPath installation is subject to the acceptance of End User LIcense Agreement (EULA) during GUI installation.

By default, the customer accepts EULA during silent or unattended installation. The EULA file is available at <Install
Directory>\PowerPath\EULA directory.

Check array configurations

Steps

● Check if the arrays attached are configured properly as per the array configuration documents.

Check NetApp storage array report_scsi_name setting provides more information on NetApp array configuration.

Gather up-to-date information

Check the Dell EMC Online Support website for current information.

● PowerPath documentation—EMC updates PowerPath documentation when it releases new features with a service pack or
when documentation errors are reported.

● Service packs and upgrades—You can download PowerPath service pack software from Dell EMC Online Support.
Determine which service packs (if any) to install after PowerPath, and whether those service packs have any additional
installation prerequisites.
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Choose a convenient time

Installing PowerPath requires that you restart the host.

Plan to install or upgrade PowerPath at a convenient time to minimize disruption to the site.

Activate the license

PowerPath/VE for Windows Hyper-V and PowerPath for Windows require separate licenses. However, the licensing process for
PowerPath/VE for Windows Hyper-V is the same as the licensing process for PowerPath for Windows.

About this task

The licensing process for both PowerPath/VE for Windows Hyper-V and for PowerPath for Windows is described in the
PowerPath Family Electronic License Ordering Process Technical Notes, available on Dell EMC Online Support. Take note of the
following regarding licenses:

Steps

● If you are upgrading from an earlier version of PowerPath, you do not need to re-register. PowerPath uses the old key.
● PowerPath Migration Enabler does not require a separate product license. The PowerPath multipathing license includes

Migration Enabler functionality for all technology types (for example HostCopy and Open Replicator).
● Type the registration number exactly as it appears on the card or letter. To reduce common typographical errors, the License

Key field accepts either uppercase or lowercase letters, and certain numbers and letters are interchangeable. Specifically, an
entry of the alphabetic letters O, I, S, and B is equivalent to an entry of the numbers, 0, 1, 5, and 8.

Prepare the host and storage system

● Go to Dell EMC Online Support and verify your environment meets the requirements found in the PowerPath and
PowerPath/VE Family for Windows Release Notes and the E-Lab Interoperability Navigator by running the Serviceability
feature of the PowerPath Management Appliance (PPMA).

● The PowerPath and PowerPath/VE Family for Windows Release Notes includes the qualified Microsoft MPIO framework
versions.

● The PowerPath and PowerPath/VE Family for Windows Release Notes includes a list of all Microsoft Hotfixes that are
required to be installed, depending on your Windows Operating System, prior to installing PowerPath.

● Configure HBA drivers. Ensure that you follow the HBA driver configuration guidelines outlined in the E-Lab Interoperability
Navigator and the HBA vendor documentation. The use of improper settings can cause erratic failover behavior, such as
greatly increased I/O delays.

● For hosts connected to storage arrays through a Fibre Channel switch (that is, a fabric), configure the HBAs by using
persistent binding for SCSI target IDs.

● Beginning with the 6.1 release of PowerPath for Windows, all drivers are signed with SHA256 certificates. For SHA256-
signed drivers to work on Windows Server 2008 R2, Microsoft hotfixes KB2921916 and KB3033929 or their superseded KBs
needs to be installed on the server. You can check the superseded KBs on Microsoft Support. PowerPath installer checks
the existence of these KBs before proceeding with the installation on 2008 R2 servers. It is possible that these KBs are
superseded by subsequent Microsoft KBs. If the superseding KBs are installed on a server, the PowerPath installer KB check
may fail even if SHA-256 support is in place. You can confirm if SHA256 support exists on the server by trying to install both
the KBs. The installation of the KBs should succeed. If it fails, the errors indicate that the KB is already installed or is not
applicable. Once you confirm that the SHA256 support is available on the host, you can bypass the PowerPath installer KB
check by passing NO_KBCHECK=1 installer argument while installing using the CLI.
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OpenSSL configuration utility

OpenSSL is packaged separately and is available for download from the Dell download site. The OpenSSL package comes with
a configuration utility which takes care of configuring the supported OpenSSL binariesthat are needed for PowerPath to work.
The script starts the EMC PowerPath Remote Management component service.

Configure OpenSSL binaries for PowerPath

The following is the procedure to configure OpenSSL binaries.

Steps

1. Download the OpenSSL package from the DELL EMC site and copy it to the windows system.

2. Extract the downloaded OpenSSL package.

3. Open the package and execute the OpenSSL_config.bat script with the option Run as administrator, to ensure that the
administrator permissions are provided. Log file PowerPath_OpenSSL.log is generated.

4. OpenSSL Software Library is distributed under Apache License 2.0. Review the license terms before installing the product.

Boot from a storage array device

The following documents provide instructions for configuring a storage array device as the boot device:

● EMC Fibre Channel with Emulex Host Bus Adapters in the Windows Environment, available on the Emulex website.
● EMC Fibre Channel and iSCSI with QLogic Host Bus Adapters in the Windows Environment, available on the QLogic website.

Prepare a cluster environment

For more information on installing PowerPath in a new or existing cluster, go to PowerPath in an MSCS cluster and PowerPath
in a Veritas Cluster Server

Install in virtual environments

The procedure to install PowerPath in virtual environments is the same as the procedure to install in physical environments. You
can follow the GUI or the CLI installation procedure described in this document.

EMC supports iSCSI and Fibre Channel (FC) connections to EMC storage using the Microsoft Software iSCSI Initiator and
Microsoft Hyper-V Virtual Fibre Channel, respectively, in a child partition. In this configuration PowerPath is supported in a child
partition to manage multiple iSCSI or FC paths. However, pass-through disks are not supported when running PowerPath in a
child partition.

Coexistence with third-party path management software

PowerPath can coexist with MPIO-based third-party path management software such as:

● Hitachi Dynamic Link Manager (HDLM)
● HP StorageWorks Secure Path
● HP StorageWorks AutoPath XP Virtual Array
● Microsoft MPIO (native multipathing)
● Veritas Dynamic Multipathing

PowerPath cannot co-manage devices with third-party path management software.

If multiple DSMs are installed to manage devices of an array, Microsoft MPIO framework currently does not ensure that a
particular DSM will always manage such devices. As a result, the effects of using PowerPath DSM and another third-party DSM
for managing the same array are undetermined. Further, when PowerPath coexists with other multipathing software to manage
exclusive arrays, an HBA cannot be shared between the two. The Microsoft MPIO documentation provides more details.
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Installation procedures
You can install using the default GUI method or through the CLI. Refer to one of the following procedures to install PowerPath.

NOTE: In Windows server 2016, the PowerPath 6.2 patch 01 or later installer now enforces two reboots when MPIO is

not installed prior to PowerPath installation. In Windows 2016, the MPIO needs a reboot for it to be configured. PowerPath

installation can be done only after the MPIO configuration, hence there are two reboots

NOTE: You must have administrative rights to install PowerPath.

NOTE: UAC settings in the host should allow drivers and system softwares to be installed.

NOTE: PowerPath should have access to make changes to the Install directory.

● Install PowerPath using the GUI (default method)
● Install PowerPath using the CLI

PowerPath installation creates installation logs by default in %ProgramData%\EMC\PowerPath\logs.

Service pack and patch installations

To install a PowerPath service pack or patch for Windows, see the following sections:

● Installing a PowerPath Service Pack for Windows
● Install a PowerPath patch for Windows

Install PowerPath using the GUI (default method)

Install PowerPath with the default interactive prompts.

Steps

1. Perform one of the following:
● If the PowerPath executable file is saved on your local system, double-click the PowerPath executable file.
● Click Start and then select Run.

In the Run window, browse to or type the name of the PowerPath installation program:

<drive>:\<PowerPath_pkg_name>

2. Select the language for this installation from the list and click Next.

Localized version of the PowerPath installers are available in Brazilian Portuguese, Latin American Spanish, French, German,
Italian, Japanese, Korean, and simplified Chinese.

3. Read and accept the End User License Agreement, and then click Next.

4. In the setup wizard welcome window, click Next.

5. In the Custom Setup dialog box, select the features for installation.

By default, Multipathing, Migration Enabler, Management Component, and support for EMC storage arrays are selected.
Clear unwanted default features or select extra features (such as third-party storage arrays such as NetApp) and then click
Next.

● To select or clear features, click the arrow and select the appropriate option from the drop-down menu:

Will be installed on local hard drive
Entire feature will be installed on local hard drive
Entire feature will be unavailable

● Click Disk Usage to view the required and available space that is needed to install selected features.
● Use the Browse option to change the destination folder.

6. Click Next.

7. If OpenSSL is not installed in the host with Management component selected, see OpenSSL configuration utility.
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8. If the installation is PowerPath upgrade installation and if powermt custom file is found, the PowerPath installer provides
an option to either keep or delete the existing powermt.custom file.

● In order for the upgrade installation to convert and keep the existing powermt.custom file, select Keep the custom
configuration file.

● If you want to delete the existing powermt.custom file, select Delete the custom configuration file.

9. In the Ready to Install dialog box, click Install.

a. Choose whether to save the path-specific information to the powermt custom file.

NOTE: The persist path information option in the powermt custom configuration file is set to ON when the

box is checked. If HBA SCSI target persistent binding is not enabled, set persist_path_info to off. Without

HBA persistent binding, the SCSI ID of the path persisted in the custom file may change after actions like HBA

enable/disable or a server reboot. This may cause powermt to display misleading information. Refer to the HBA

management software documentation for information about how to enable SCSI target persistent binding.

b. If PowerPath detects that files to be updated are in use, select one of the following options:

● Automatically close and attempt to restart applications.
● Do not close applications (A reboot will be required.)

If PowerPath does not detect files in use, go to Step d.

c. Click OK.
d. When the EMC Licensing Tool prompt displays, type your 24-digit registration number in the License Key field, and then

click Add.

NOTE:

● PowerPath for Windows and PowerPath/VE for Windows Hyper-V each requires a separate license. The licensing

procedure is the same for each.

● When upgrading PowerPath, the existing license key is saved and no input is required.

● To enable additional array support, enter the license keys. Migration Enabler is enabled when you enter a valid

multipathing license key.

e. Click OK.

10. In the Installation Wizard Completed dialog box, to change the Management Component default settings, click Launch
Management Component Configuration Utility and then click Finish. The Management Component is disabled by
default.

NOTE: If you do not launch the Management Component Configuration utility during installation, you can configure the

Management Component later by going to Start > Programs > EMC > Configuration and selecting Management

Component Configuration.

If you launched the Management Component Configuration utility, review the following parameters.

● Ensure that Enable PowerPath Management Component is selected. It is selected by default.
● In the Port Number field, maintain the default and recommended port value of 9083 or change the port value to a value

between 49152 and 65535 if another application is already using the default port (9083).
● In the Heartbeat Interval field, maintain the default value of 10 minutes or change the heartbeat interval value to a value

between 1 and 60. The heartbeat interval is based on the number of hosts being managed.
● Click Disable Single Path Symmetrix GateKeeper Setup Warnings to maintain the default setting if you do not want

to report Setup errors for Symmetrix gatekeeper devices that are configured with a single path. Otherwise, clear the
check box if Symmetrix gatekeeper devices are multi-pathed in your data center.

NOTE: PowerPath supports both single-path and multi-path configured Symmetrix gatekeepers. Consult your

network administrator for more information about your Symmetrix gatekeeper configuration.

● Click Use Windows perfmon forPowerPath PMI counters to make PowerPath performance metrics (PowerPath
counters) available in the Windows Performance monitoring tools.

● To restore the default options, click Restore Default.

11. Click Yes to reboot now or No to reboot later.

12. (optional) If you installed Migration Enabler, and if you are not planning to use this feature, disable this service and change
the Startup type to disabled.

13. When the host restarts, follow the instructions in After installing PowerPath
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Install PowerPath using the CLI

Install using the more advanced command line interface. Use spaces to separate multiple properties.

Prerequisites

The customer accepts the End User License Agreement by default during silent or unattended installation.

Steps

1. Type the following command syntax to install PowerPath.

<drive>:\<PowerPath_pkg_name> <install_parameters> /v"<Property>=<Value>"
● For a silent or unattended installation, which does not require user input.

Silent installations include the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>
NOTE: Silent or unattended installation errors are logged in <logfile>, the location specified in the installation

command. No error message is displayed in the Windows PowerPath Administrator GUI.

● For an interactive installation, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>

drive The drive letter, for example, C.

PowerPath_pkg_
name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is the product version. For
example, PowerPath 6.3.

install_parameter
s

One or more parameters (/s, /v, or /p) that are described in CLI parameters.

logfile Creates the log file where the log message is sent, for example, C:\logs\PPsetup.log. Ensure
that the specified directory exists within the specified path.

Property=Value One or more optional properties that are described under the /v parameter in CLI parameters.

The following examples provide scenarios using the silent and interactive CLI methods.

● Silent installation

Install all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for EMC
storage arrays) using the silent method and to also set the PowerPath license and disable restart.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPsetup.log
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

● Unattended installation

Install all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for EMC
storage arrays) using the unattended method and to also set the PowerPath license and disable restart.

Unattended installations include the /p parameter.

C:\EMCPower.X64.signed.<version>.<build>.exe /p /v"/L*v C:\logs\PPsetup.log
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

● Interactive installation

Install PowerPath using the interactive CLI method and to set the PowerPath license, copy, and install PowerPath files to
C:\Test folder, disable restart, and install components to support Dell SC, IBM ESS, and Hitachi storage arrays.

C:\EMCPower.X64.signed.<version>.<build>.exe /v"/L*v C:\Install_IBM_HDS_NETAPP.log
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test NO_REBOOT=1
ADDLOCAL=SC,IBM,HDS,NETAPP"

2. After installing PowerPath, restart the host and then follow the instructions in After installing PowerPath.

CLI parameters describes the parameters and options.
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After installing PowerPath
This section describes post-installation tasks.

Verify the configuration

Verify the PowerPath configuration after installation.

Steps

1. After the host restarts, check that PowerPath is fully configured with multiple paths to logical devices and (if appropriate)
correct zones when you start.

2. Verify if the configuration is correct.

If PowerPath sees no devices, but the devices are seen by the operating system, then verify that the devices are configured
for PowerPath support.

powermt display
powermt display dev=all
powermt display ports

3. Save the verified configuration.

powermt save

Verify a patch installation

Once a patch is installed, it is listed as a subentry under the PowerPath entry in Add/Remove Programs or Programs and
Features.

Steps

● Verify that the PowerPath patch appears in the list of updated programs.
○ Click Show updates in Add/Remove Programs.
○ Click View installed updates in Programs and Features.

Configure the PowerPath Management Pack for Microsoft
Operations Manager

You can configure the PowerPath management daemon to remotely monitor specific PowerPath events.

This feature is available in a separate software package available on Dell EMC Online Support. The management daemon
integrates with Microsoft Operations Manager and allows you to retrieve license and version information from remote
PowerPath hosts. It also can generate alerts when paths or volumes remain dead for a configurable time frame. The PowerPath
Management Pack for Microsoft Operations Manager User Guide provides more information on configuring and using the
management daemon.

Adding features to an existing installation
If PowerPath is installed on your host and you want to install additional features, such as PowerPath Migration Enabler or
components to support third-party arrays, follow one of these procedures:

Add features to an existing installation using the GUI

Add features to an existing installation using the CLI
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Add features to an existing installation using the GUI

Steps

1. Using Add/Remove Programs or Programs and Features select the installed version of PowerPath and then click
Change.

2. In the Setup wizard welcome window, click Next.

3. Select Change and click Next.

4. Select the feature that you want to install from the drop-down list.

NOTE:

● A selected feature displays a hard drive icon next to it. A red X indicates that the feature is not selected.

● The icon next to each feature name indicates the feature’s install state. Click Help in the Custom Setup dialog box

for more information about the icons.

5. Select the option to install the feature on the local hard drive and click Next.

6. Click Install.

7. Click Finish.

8. Click Yes to reboot now or No to reboot later.

NOTE: If the User Account Control (UAC) is configured in the Admin Approval mode, running the PowerPath setup

program to change, repair, or to uninstall PowerPath 6.3 and later versions, using Add/Remove Programs or

Programs and Features through the control panel results in multiple elevation prompts.

NOTE: If you are installing Migration Enabler or Management Component then a reboot is not required. However,

installing these features with any other feature requires a reboot.

Add features to an existing installation using the CLI

Steps

● Add features to an existing installation.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> LICENSENUM=<license_key> NO_REBOOT=1
ADDLOCAL=<feature>"
For example, to install XtremIO and Invista, type the following command on a single line.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPsetup.log 
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1 ADDLOCAL=XTREMIO,INVISTA"

Results

When the NO_REBOOT=1 parameter is used, reboot manually after installation.
NOTE:

If you are installing Migration Enabler or Management Component then a reboot is not required. However, installing these

features with any other feature requires a reboot.

CLI parameters describes the parameters and options.

Installing a PowerPath Service Pack for Windows
To install a PowerPath for Windows service pack, follow the installation instructions in:

Install PowerPath using the GUI (default method)

Install PowerPath using the CLI
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Install a PowerPath patch for Windows

Prerequisites

● Ensure that the PowerPath base package is installed. The PowerPath base package must be installed on the host before you
can install a PowerPath patch for Windows. PowerPath patches for Windows are not full package installations and will only
update a specific set of files or drivers. Installation of the patch does not change the PowerPath version.

● If the patch has fixes for additional PowerPath features (such as, Migration Enabler), then that feature must be enabled
before you install the patch for the patch to be able to apply its fixes.

● A lower version patch can be applied on top of a higher version one (Multiple patches can be installed and can coexist).

About this task

Alternatively, use the command line to install the patch.

<Patch.exe> /s /v"/q NO_REBOOT=1 /L*v C:\logs\Install_PP_Patch.log"

Include NO_REBOOT=1 so that you can manually restart at a convenient time.

Steps

1. Double click the patch executable file.

2. Click Update in the Install Welcome dialog box.

3. Click Finish.

4. Click Yes to reboot the host or No to reboot later.

Unsupported installation changes
This section describes unsupported installation changes.

About this task

Uninstalling an earlier version of PowerPath without rebooting, and then installing a newer version may cause a system crash. To
avoid this issue, reboot after installing, uninstalling, or upgrading PowerPath.

NOTE: When the system is not rebooted after installing, uninstalling, or upgrading PowerPath, the operating system

confuses the uninstallation of old drivers with the installation of new drivers, causing a system panic.

Downgrade PowerPath

If you want to run an earlier version of PowerPath, you must roll back PowerPath.

About this task

Do not try to install an earlier version of PowerPath on hosts currently running a more recent version of PowerPath.

Steps

1. Uninstall the newer version of PowerPath.

2. Restart the host.

3. Install the earlier version of PowerPath.
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Configuring PowerPath
This chapter contains the following sections:

Topics:

• Overview
• Adding new paths to a PowerPath logical device
• Adding new logical devices to the PowerPath configuration
• Removing paths to PowerPath logical devices
• Removing PowerPath logical devices
• Configuring the Microsoft iSCSI Initiator for PowerPath
• Adding PowerPath PMI counters to Windows Performance Monitor

Overview
You must reconfigure PowerPath after making configuration changes that affect host-to-storage-system connectivity or logical
device identification.

For example:

● Fibre Channel switch zone changes
● Adding or removing Fibre Channel switches
● Adding or removing HBAs or storage-system ports
● Adding or removing logical devices
● Redeploying existing logical devices

NOTE: If you do not reconfigure PowerPath after making configuration changes, many of these changes are treated as

unintentional, and PowerPath tries to prevent them from affecting applications.

Many platform-specific and some PowerPath reconfiguration operations fail when the affected logical devices are in use (either
just marked alive or with I/O in progress). This condition is noted in specific places in the procedures that follow. After any
reconfiguration, you must monitor the outcome of individual reconfiguration steps and confirm that the resulting changes are as
expected, before relying on the new configuration. Otherwise, some paths may not be as expected.

Whenever you make any changes to the default settings, such as changing the default load-balancing policies, then you must
run the powermt save command to ensure that the new settings persist across restart.

NOTE: In Windows 2K16 configurations MPIO requires a restart for it to be configured. InstallPowerPath after the MPIO

configuration. Hence, PowerPath on Windows 2K16 needs two restarts.

Adding new paths to a PowerPath logical device
This procedure adds new paths to a logical device already configured (with at least one path) in PowerPath. This procedure can
be done without interruption to running applications on Microsoft hosts.

About this task

CAUTION: All operations must succeed for the reconfiguration to be successful. If any step fails, resolve that

issue before proceeding. Do not use the new configuration until the entire procedure completes successfully.

NOTE: Path limit: Do not configure more than 32 paths per logical device.

2
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Steps

1. Confirm the current configuration.

powermt display
2. Confirm the configuration of the logical devices to which new paths are added.

powermt display dev=all
3. Ensure that the number of logical devices, hardware paths, and I/O paths are as expected. The path state should be alive for

known good paths and dead for known bad paths.
If there is a problem, correct it before proceeding.

4. Make physical path additions as required:

a. Map the logical device to additional storage-system ports.
b. Add new HBAs. For details, refer to the vendor documentation.
c. Attach cables.
d. Rezone Fibre Channel switches.

5. If using SAN Manager™, Volume Logix, or Access Logix, make new paths available to the host using those tools.

6. Scan for hardware changes in the device manager or alternately, restart.

In some cases, the operating system may prompt for a restart after new devices are added.

7. Reconfigure PowerPath.

8. Inspect the new PowerPath configuration.

a. Confirm the path state.

powermt display dev=all
The new paths should be displayed with a state of alive.

b. Test all paths.

powermt restore
c. Scan operating system error logs to ensure that no errors are logged against the new paths.

9. Correct any issues that are detected.

10. Save the new configuration.

powermt save

Adding new logical devices to the PowerPath
configuration
This procedure adds new logical devices (with one or more paths) to be managed by PowerPath and applies to managed storage
system classes only.

About this task

Logical devices can be added without interruption of service, since no existing application can be using a logical device that is
not yet available. After successful configuration, new pseudo devices can be used.

CAUTION: All operations must succeed for the reconfiguration to be successful. If any step fails, resolve that

issue before proceeding. Do not use the new configuration until the entire procedure completes successfully.

Steps

1. Confirm the current configuration.

powermt display
Ensure that the number of logical devices, hardware paths, and I/O paths are as expected. The path state should be alive for
known good paths and dead for known bad paths.

2. Make logical device and physical path changes as required:

a. Create new logical devices.
b. Map logical devices to one or more storage-system ports.
c. Add new HBAs. For details, the vendor documentation provides more details.
d. Attach cables.
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e. Rezone Fibre Channel switches.

3. If using SAN Manager, Volume Logix, or Access Logix, make new paths available to the host using those tools.

4. Scan for hardware changes in the device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices are added.

5. Reconfigure PowerPath.

6. After adding LUNs to a storage group and scanning the disk via the device manager/diskpart scan operation or through a
restart, the powermt display dev=all command may return an error count of 1 for the new LUNs.
For example, if there are 4 paths configured between the host and the array, PowerPath displays four errors against each
LUN, one error for each path.

Run the powermt restore command to reset the error count to 0.

NOTE: When a new path is added to the Windows host, the system restarts the corresponding path device to complete

the software installation, resulting in a path dead message in the system log which can be ignored.

7. Inspect the new PowerPath configuration.

a. Confirm the path state.

powermt display dev=all
All paths associated with the new logical devices should be displayed with a state of alive.

b. Test all paths to the new logical device.

powermt restore
c. Scan operating system error logs to ensure that no errors are logged against the new paths and logical device.

8. Correct any issues that are detected, before saving the PowerPath configuration or using the new logical device.

9. Set PowerPath-specific options for the new logical devices, such as load-balancing and failover policy, path modes, write
throttle enablement, and priority.

10. Reconfigure PowerPath.

11. Save the new configuration.

powermt save
12. On the host where EMC ControlCenter® is installed, refresh the ControlCenter database device information.

The ControlCenter documentation provides more information.

Removing paths to PowerPath logical devices
This procedure removes some (but not all) paths to logical devices configured in PowerPath.

About this task

CAUTION: Do not remove the last live path to a logical device unless you plan to remove the logical device

entirely, as data access is interrupted. If a PowerPath device is open, powermt remove does not remove that

device or the last path to that device.

NOTE: Failure to follow all the steps in this procedure correctly can result in data loss and errors that affect the operating

system.

Steps

1. Confirm the configuration of the logical devices from which paths will be removed.

powermt display dev=all
2. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad paths.

3. If there is a problem, correct it before proceeding.

4. Identify the physical paths to be removed or zoned out, and confirm that there are other paths to the affected logical
devices.

Otherwise, applications using those logical devices could experience I/O errors when you proceed.

5. Identify the PowerPath HBA number that is associated with the paths to be removed.

powermt display dev=all
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In complex topologies, there can be multiple paths on an HBA.

6. Set the mode to standby for all paths to be removed.

powermt set mode=standby
If an HBA is to be removed, specify the HBA (instead of the device) when running powermt set mode

7. Physically disconnect the paths or logically disconnect them by removing them from active zones.

As a result, the operating system may log some error messages. However, PowerPath prevents these errors from affecting
applications.

8. Scan for hardware changes in the device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices are added.

9. Confirm that the paths listed as dead are the ones that you intended to remove.

powermt restore
10. Remove the paths.

powermt remove
Specify both the hba and dev arguments

CAUTION: If you do not specify the hba argument, all paths to the specified logical device are removed.

11. Remove HBAs as required and reboot if needed.

12. Inspect the new PowerPath configuration:

a. Confirm the number of paths.

powermt display
The output should show fewer total paths than before. All paths should have a state of optimal.

b. Confirm the path state.

powermt display dev=all
All remaining paths associated with the affected logical devices should be displayed with a state of alive.

13. Correct any issues detected before saving the PowerPath configuration or using the new logical devices.

14. Save the new configuration.

powermt save

Removing PowerPath logical devices
This procedure removes logical devices (with all configured paths to those logical devices) configured in PowerPath. Logical
devices can be removed without interruption of service only if no applications are using or configured to use the logical devices
you are removing. The procedure may fail if any application is using a device that is associated with the path to be removed.

Steps

1. Inspect the current PowerPath configuration:

a. Confirm the current configuration.

powermt display
Ensure that the total number of logical devices, hardware paths, and I/O paths are as expected.

Since one or more paths may have failed, not all paths may be listed as optimal.

b. Confirm the configuration of the logical devices that are removed.

powermt display dev=all
c. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad paths.

2. If either of the above displays indicates a problem, correct it before proceeding.

3. Identify the logical devices to be removed.

4. Identify the physical paths that also may be removed.

5. Identify the PowerPath HBA number that is associated with the paths to be removed.

powermt display dev=all
In complex topologies, there can be multiple paths on an HBA.
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6. Reconfigure all applications that are using the logical devices to be removed, so they are no longer configured to use them.

7. Unmount file systems.

8. Remove the volume groups using the appropriate volume manager command.

9. Scan for hardware changes in the device manager. Alternately, restart.

10. If using SAN Manager™, Volume Logix, or Access Logix, remove access to the logical devices to be removed, using those
tools.

As a result of this step, the operating system may log some error messages. These are expected and are harmless.

11. Remove the paths.

powermt remove dev=all
12. Save the new configuration.

powermt save
13. Disconnect physical paths or zone out paths with switched fabric zone changes as required.

14. Confirm that the paths that are listed as dead are associated with the logical devices you intend to remove.

powermt restore
15. Depending on the type of HBA installed, scan for hardware changes in the device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices are added.

16. Inspect the new PowerPath configuration:

a. Confirm the number of paths.

powermt display
The output should show fewer total paths than before. All paths should have a summary state of optimal.

b. Confirm the path state.

powermt display dev=all
All remaining paths that are associated with the affected logical devices should be displayed with a state of alive.

17. Correct any issues that are detected above, before saving the PowerPath configuration or using the new logical devices.

18. Save the new configuration.

powermt save

Configuring the Microsoft iSCSI Initiator for
PowerPath

About this task

Refer to the recommended array and hardware guidelines.

Steps

● Select Enable multi-path while creating sessions on the target and then click OK.

The Microsoft iSCSI initiator is available by default.

Enabling and disabling the iSCSI NIC IP display feature

The iSCSI display feature is disabled by default. To see the iSCSI NIC IP for every path in powermt display, enable the
iSCSI display feature. Enabling or disabling the iSCSI IP display feature does not affect the iSCSI functionality. This display
feature has minimal support; PowerPath Host, which has multiple NIC IPs configured in the same subnet, is not supported.

Prerequisites

Perform the following procedure to ensure that a specific NIC IP is assigned to every iSCSI target. Repeat the following steps
for each iSCSI target in the Targets tab of the Microsoft Software iSCSI Initiator Properties. This process ensures only one path
is dead at a time instead of all paths going dead together.
1. Select a target.
2. Click Disconnect to disconnect the target.
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3. Click Connect and then click Advanced... to go to Advanced Settings.
4. Set the Local Adapter to Microsoft iSCSI Initiator. Set the Initiator IP to the specific NIC IP from the same subnet as that of

the Target IP.
5. Click Apply and OK.

About this task

To enable and disable the iSCSI display feature:

Steps

1. To enable the iSCSI display feature, set the following environmental variable:

set EMCPMPAPI_ISCSI_DISPLAY=1

2. To disable the iSCSI display feature, unset the environmental variable (if already set) by running the following command:

set EMCPMPAPI_ISCSI_DISPLAY=

Adding PowerPath PMI counters to Windows
Performance Monitor
Path Management Insight (PMI) capabilities help performance monitoring by characterizing I/O patterns and diagnosing I/O
problems.

About this task

The PMI counter and timers on the Performance Monitor framework is published by the V2 Performance Counter provider. The
provider which is hosted by the PowerPath Management Service, is part of the PowerPath Management Component and is
enabled by default. Each PMI counter and timer is present in the perfmon. Two specific PowerPath PMI counters are displayed
as part of the Windows Performance Monitoring tools under Performance\Performance Tools\Performance Monitor. These
independent counters are also listed in the Add Counters wizard and display the following information:

● PowerPath Volume PMI Data—contains all counters and timers for Volumes
● PowerPath Path PMI Data—contains all counters and timers for Paths

Apart from powermt set perfmon, there are two more commands that can be used to collect insights for enhanced
performance information:

● powermt display perf dev
● powermt display perf bus
The output of these commands provide:

● Read, Write, and Total Throughput
● Read, Write and All Average Response Time
● Latency Distribution
● Retry delta
● Error delta

For more information on these commands, see the PowerPath Family CLI and System Messages Reference.

For more information on adding counters, refer to Microsoft Performance Monitoring documentation.

Steps

● Start collecting data.

powermt set perfmon=<on>
Setting the perfmon command to On initializes the performance monitoring counter and measurements.
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Upgrading PowerPath
This chapter contains the following sections:

Topics:

• Before upgrading
• Upgrade procedures
• After upgrading PowerPath

Before upgrading
Before upgrading PowerPath or installing a service pack:

About this task

NOTE: You do not need to remove the previous version of PowerPath before upgrading to PowerPath 6.x.

Steps

1. Go to Dell EMC Online Support and do the following:

a. Check for the most current information. EMC updates release notes periodically and posts them on Dell EMC Online
Support.

b. Download the latest version of EMC Reports, available on Dell EMC Online Support, and then check the serviceability
data of Dell EMC PowerPath Management Appliance.

c. Download the PowerPath software on Dell EMC Online Support at Downloads and save it to your local directory.

Refer to E-Lab Interoperability Navigator and Release Notes of the PowerPath version to be upgraded to check for the
supported arrays.

2. Save the current PowerPath configuration using one of the following methods:

● Save the latest PowerPath configuration.

powermt save
If the custom file is being saved to a non-default location, refer to the Upgrading PowerPath custom file conversion
section.

● In the Windows PowerPath Administrator GUI, right-click the root node and then select All Tasks > Save Config as.
Specify a file name and click Save.

NOTE: PowerPath stores configuration information in a configuration file that may be loaded at boot time. When

using the Windows PowerPath Administrator GUI, the configuration file can be saved only under the default filename.

After a service pack is applied, the configuration file format may have changed, resulting in the configuration file no

longer being backward compatible.

3. Stop powermt display if it is running.

4. Close the Windows PowerPath Administrator GUI if it is open.

5. Open 'services.msc' at the command prompt and verify that the below PowerPath services are operational:

● EMC PowerPath Service
● EMC PowerPath Migration Service

NOTE: EMC PowerPath Remote Management component service will also be running if it was enabled in the existing

PowerPath version.

6. Check 'powermt display dev=all' to verify that there are no dead paths.

a. Fix any SAN issues that caused the dead paths.
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b. If the dead paths are no longer required, remove the dead paths. The PowerPath Family CLI and System Messages
Reference Guide provides more information on how to remove the dead paths.

7. Verify that at least 250 MB of free space is available in the installing drive.

8. Verify that there are no active migrations pending.

9. Ensure that there are no fabric or array configurations changes in progress.

10. If upgrading to claim support for a newly added array, ensure that the corresponding array feature is enabled. Refer to the
Installation and upgrade procedures section for information on how to enable a feature.

11. Uninstall any PowerPath hot fixes on the host. Use Add/Remove Programs or Programs and Features to verify if hot
fixes are installed.

12. Review the information in Supported upgrades.

Upgrade procedures
You can upgrade using the default GUI method or through the CLI. Refer to one of the following procedures to upgrade
PowerPath.

NOTE: Do not add new paths during upgrade.

NOTE: You must have administrative rights to install PowerPath.

NOTE: UAC settings in the host should allow drivers and system softwares to be installed.

NOTE: PowerPath should have access to make changes to the Install directory.

● Upgrade PowerPath using the GUI (default method)
● Upgrade PowerPath using the CLI

PowerPath installation creates installation logs by default in %ProgramData%\EMC\PowerPath\logs.

Upgrade PowerPath using the GUI (default method)

Upgrade PowerPath with the default interactive prompts.

Steps

1. Perform one of the following:
● If the PowerPath executable file is saved on your local system, double-click the PowerPath executable file.
● Click Start and then select Run.

In the Run window, browse to or type the name of the PowerPath installation program:

<drive>:\<PowerPath_pkg_name>

2. Select the language for this installation from the list and click Next.

Localized version of the PowerPath installers are available in Brazilian Portuguese, Latin American Spanish, French, German,
Italian, Japanese, Korean, and simplified Chinese.

3. Read and accept the End User License Agreement, and then click Next.

4. In the setup wizard welcome window, click Next.

5. In the Custom Setup dialog box, select the features for installation.

By default, Multipathing, Migration Enabler, Management Component, and support for EMC storage arrays are selected.
Clear unwanted default features or select extra features (such as third-party storage arrays such as NetApp) and then click
Next.

● To select or clear features, click the arrow and select the appropriate option from the drop-down menu:

Will be installed on local hard drive
Entire feature is installed on local hard drive
Entire feature will be unavailable

● Click Disk Usage to view the required and available space needed to install selected features.
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● Use the Browse option to change the destination folder.

6. Click Next.

7. If OpenSSL is not installed in the host with Management component selected, see OpenSSL configuration utility.

8. In case of PowerPath upgrade installation and if powermt custom file is found, the PowerPath installer provides an option
to either keep or delete the existing powermt.custom file.

● In order for the upgrade installation to convert and keep the existing powermt.custom file, select Keep the custom
configuration file.

● If you want to delete the existing powermt.custom file, select Delete the custom configuration file.

9. In the Ready to Install dialog box, click Install.

a. Choose whether to save the path specific information to the powermt custom file.

NOTE: The persist path information option in the powermt custom configuration file is set to ON when the

box is checked. If HBA SCSI target persistent binding is not enabled, set persist_path_info to off. Without

HBA persistent binding, the SCSI ID of the path persisted in the custom file may change after actions like HBA

enable/disable or a server reboot. This may cause powermt to display misleading information. Refer to the HBA

management software documentation for information about how to enable SCSI target persistent binding.

b. If PowerPath detects that files that need to be updated are currently in use, select one of the following options:

● Automatically close and attempt to restart applications.
● Do not close applications (A reboot will be required.)

If PowerPath does not detect files currently in use, proceed to Step d.

c. Click OK.
d. When prompted by the EMC Licensing Tool, type your 24-digit registration number in the License Key field, and then

click Add.

NOTE:

● PowerPath for Windows and PowerPath/VE for Windows Hyper-V each require a separate license. The licensing

procedure is the same for each.

● When upgrading PowerPath, the existing license key is saved and no input is required.

● To enable additional array support, enter the license keys. Migration Enabler is enabled when you enter a valid

multipathing license key.

e. Click OK.

10. In the Installation Wizard Completed dialog box, to change the Management Component default settings, click Launch
Management Component Configuration Utility and then click Finish. The Management Component is disabled by
default.

NOTE: If you do not launch the Management Component Configuration utility during installation, you can configure the

Management Component later by going to Start > Programs > EMC > Configuration and selecting Management

Component Configuration.

If you launched the Management Component Configuration utility, review the following parameters.

● Ensure that Enable PowerPath Management Component is selected. It is selected by default.
● In the Port Number field, maintain the default and recommended port value of 9083 or change the port value to a value

between 49152 and 65535 if another application is already using the default port (9083).
● In the Heartbeat Interval field, maintain the default value of 10 minutes or change the heartbeat interval value to a value

between 1 and 60. The heartbeat interval be based on the number of hosts being managed.
● Click Disable Single Path Symmetrix GateKeeper Setup Warnings to maintain the default setting if you do not want

Setup errors to be reported for Symmetrix gatekeeper devices that are configured with a single path. Otherwise, clear
the check box if Symmetrix gatekeeper devices are multi-pathed in your data center.

NOTE: PowerPath supports both single-path and multi-path configured Symmetrix gatekeepers. Consult your

network administrator for more information about your Symmetrix gatekeeper configuration.

● Click Use Windows perfmon forPowerPath PMI counters to make PowerPath performance metrics (PowerPath
counters) available in the Windows Performance monitoring tools.

● To restore the default options, click Restore Default.

11. Click Yes to reboot now or No to reboot later.

12. When the host restarts, follow the instructions in After upgrading PowerPath
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Upgrade PowerPath using the CLI

Upgrade using the more advanced command line interface. Use spaces to separate multiple properties.

Prerequisites

The customer accepts the End User License Agreement by default during silent or unattended installation.

Steps

1. Type the following command syntax to upgrade PowerPath.

<drive>:\<PowerPath_pkg_name> <install_parameters> /v"<Property>=<Value>"
● For a silent or unattended upgrade, which does not require user input.

Silent upgrade includes the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>
NOTE: Silent or unattended upgrade errors are logged in <logfile>, the location specified in the upgrade

command. No error message is displayed in the Windows PowerPath Administrator GUI.

● For an interactive upgrade, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>

drive The drive letter, for example, C.

PowerPath_pkg_
name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is the product version. For
example, PowerPath 6.3.

install_parameter
s

One or more parameters (/s, /v, or /p) that are described in CLI parameters.

logfile Creates the log file where the log message is sent, for example, C:\logs\PPsetup.log. Ensure
that the specified directory exists within the specified path.

Property=Value One or more optional properties that are described under the /v parameter in CLI parameters.

The following examples provide scenarios using the silent and interactive CLI methods.

● Silent upgrade

Install all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for EMC
storage arrays) using the silent method and to also set the PowerPath license and disable restart.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPsetup.log
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

● Unattended upgrade

Install all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for EMC
storage arrays) using the unattended method and to also set the PowerPath license and disable restart.

Unattended installations include the /p parameter.

C:\EMCPower.X64.signed.<version>.<build>.exe /p /v"/L*v C:\logs\PPsetup.log
LICENSENUM=0000-0000-0000-0000-0000-0000 NO_REBOOT=1"

● Interactive upgrade

Upgrade PowerPath using the interactive CLI method and to set the PowerPath license, copy, and install PowerPath files
to C:\Test folder, disable restart, and install components to support Dell SC, IBM ESS, and Hitachi storage arrays.

C:\EMCPower.X64.signed.<version>.<build>.exe /v"/L*v C:\Install_IBM_HDS_NETAPP.log
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test NO_REBOOT=1
ADDLOCAL=SC,IBM,HDS,NETAPP"

2. After upgrading PowerPath, restart the host and then follow the instructions in After upgrading PowerPath.

CLI parameters describes the parameters and options.
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After upgrading PowerPath
This section describes post-upgrade tasks.

Verify the configuration

Verify the PowerPath configuration after upgrade.

Steps

1. Save the configuration.

● After the host restarts, check that PowerPath is fully configured with multiple paths to logical devices and (if
appropriate) correct zones when you start. Check that the devices from the new arrays supported by the upgraded
PowerPath version are configured correctly.

Refer to the E-Lab Interoperability Navigator and Release Notes of the upgraded PowerPath version to check for the
supported arrays.

● Verify if the configuration is correct. If PowerPath sees no devices from the newly supported arrays, but the devices are
seen by the operating system, then verify that the devices are configured for PowerPath support.

powermt display
powermt display dev=all
powermt display ports

NOTE: After PowerPath installs or upgrades, verify and save the configuration. If you upgraded with an existing

custom file, internal information in the custom file may need to be updated with information from the new

PowerPath version. To update the custom file, run powermt save when the configuration is verified as expected.

● Save the verified configuration.

powermt save

2. Verify that devices from arrays whose support is deprecated in the upgraded PowerPath version will not be claimed by
PowerPath. If the corresponding dead devices are still present in the host, run powermt check force to remove those
corresponding dead paths and powermt save to save the updated configuration information.

Refer to Release Notes of the upgraded PowerPath version to check for arrays whose support is deprecated.

3. Verify that any new parameters added or parameter values changed in the upgraded PowerPath version are reflected
correctly. powermt display dev=all
Refer to Release Notes of the upgraded PowerPath version to check if any new parameters are added or if any default
parameter values are changed.

Supported upgrades

Before upgrading, ensure your environment meets these requirements:
● Do not remove redundant cable connections from the array.
● Upgrading the Windows operating system provides information on upgrading Windows operating systems that have

PowerPath installed.
● Windows Server Core 2012 and later—If PowerPath is installed through the GUI on the core version, the license key dialog

box will not appear. Use the emcpreg utility to add the license key before rebooting.

● Upgrade using either the interactive GUI or the interactive CLI method.
● Upgrading PowerPath in a Boot from SAN environment—You can upgrade PowerPath in a Boot from SAN environment

using the same procedure that you would use in other environments.
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Upgrade PowerPath custom file conversion

When the powermt.custom file is stored in a location other than the default location, the custom file will not be converted
when upgrading PowerPath. This may cause error messages to appear after upgrading to PowerPath and running powermt
load.

Prerequisites

In order for the upgrade to convert the powermt.custom file, perform the following procedure before beginning the upgrade.

About this task

If you upgrade PowerPath without converting the powermt.custom file, you must recreate the settings in PowerPath 6.x.

Steps

1. Copy the powermt.custom to the default <PowerPath_Installation_Directory>\PowerPath directory.

2. During the upgrade, when prompted, select to keep the existing custom file.

Results

After the upgrade and restart, the settings that are saved in the powermt.custom file will be automatically loaded.
NOTE: Without persistent binding, the SCSI ID of a LUN may change, leading to ghost paths appearing during a host

restart with a saved custom file configuration. This may cause powermt to display misleading information. You may also see

dead paths in case these paths have different SCSI IDs. In such cases, you will also see more paths per LU than what was

actually configured in the SAN environment. Ghost paths can be avoided by setting the persist_path_info to OFF. The

PowerPath Family CLI and System Messages Reference Guide provides more information.

Upgrading the Windows operating system

You can upgrade the Windows operating system to a major release (from Windows Server 2003/2003 R2, to Windows Server
2008 R2 or later) or to its service pack.

NOTE: The E-Lab Interoperability Navigator and the PowerPath and PowerPath/VE Family for Windows Release Notes

provide information on the required service packs on different operating systems, supported versions of PowerPath, and

any other system information that may apply to the operating system you plan to install.

Upgrade to Windows Server 2008 R2 and later

When upgrading the operating system in one of the following scenarios:

About this task

● From Windows Server 2003/2003 R2 (with PowerPath installed) to Windows Server 2008 R2 or later
● From Windows Server 2008 (with PowerPath installed) to Windows Server 2008 R2 or later
● From Windows Server 2008 R2 (with PowerPath installed) to Windows Server 2012 or later
The Windows operating system migration agent does not re-install most PowerPath drivers during the upgrade. After the
upgrade, all PowerPath functionalities are disabled. When upgrading in a Boot from SAN environment, the operating system
upgrade may fail and the system may not restart. This issue is also documented in Knowledgebase Solution emc221704.

Steps

1. Remove PowerPath.

2. Upgrade the Windows operating system.

3. Install PowerPath.
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Install Windows operating system service packs

Steps

● You do not need to uninstall PowerPath before installing an operating system service pack.
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Removing PowerPath
This chapter contains the following sections:

Topics:

• Before removing PowerPath
• Removing PowerPath software or components
• Uninstalling PowerPath with Windows OS tools
• PowerPath for Windows Patch removal
• PowerPath uninstallation troubleshooting
• Disconnecting redundant paths to the storage system

Before removing PowerPath

About this task

NOTE: If you try to uninstall PowerPath when there are active migrations, the message Migration(s) is (are)
pending. Cannot uninstall. appears and the uninstallation process aborts. Contact Customer Support if you see

the message An internal error has occurred. Migrations may be pending.

Steps

1. Check Dell EMC Online Support for the most current information.

EMC updates release notes periodically and posts them on Dell EMC Online Support.

2. Stop any application actively sending I/O.

In addition, close any remaining applications and client files to avoid warning messages when rebooting after the uninstall.

Removing PowerPath software or components
You can remove PowerPath and all related components, or you can remove a specific feature, such as Migration Enabler. You
can also remove specific multipathing components you may no longer need, such as components to support third-party arrays.

About this task

Steps

● You can use the Windows Add/Remove Programs or Programs and Features tools to remove PowerPath, or you can use the
more advanced PowerPath command line interface.

Use one of these methods to uninstall PowerPathsoftware or features:
○ Uninstalling PowerPath with Windows OS tools
○ Uninstalling PowerPath using the CLI

Results

NOTE: Reboot after removing PowerPath.

4
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Uninstalling PowerPath with Windows OS tools
The procedures in this section describe how to uninstall PowerPath software or components using Windows operating system
tools.

Example

● Removing PowerPath removes PowerPath multipathing and makes other PowerPath features unavailable for installation
changes through the Windows PowerPath Administrator GUI. Future installation changes can only be made through the
PowerPath executable file or the PowerPath CLI once you complete this procedure.

● Removing PowerPath features removes specific PowerPath features, such as Migration Enabler, Management Component,
or components that provide support for third-party arrays.

● PowerPath for Windows Patch removal removes specific PowerPath patches.

Removing PowerPath

Use this procedure to completely remove PowerPath.

Steps

1. Using Add/Remove Programs or Programs and Features uninstall the installed version of PowerPath.

● If User Account Control (UAC) is turned on, click Yes on the elevation.
● If you belong to the Administrative group, click Allow in the elevation.
● If you are a standard user, give the administrative credentials to uninstall.

2. When prompted to remove PowerPath, click Yes.

3. When prompted to reboot the host, click No to reboot later.

You can reboot after disconnecting redundant cables.

4. Complete the steps in Disconnecting redundant paths to the storage system

Removing PowerPath features

Use this procedure to remove specific PowerPath features.

Prerequisites

NOTE: You cannot uninstall PowerPath multipathing for EMC arrays using this procedure. Only the complete uninstall

procedure removes default multipathing components.

Steps

1. Using Add/Remove Programs or Programs and Features select the installed version of PowerPath and click Change/
Remove.

2. In the setup wizard welcome window, click Next.

3. Click Change.

4. To select a feature to uninstall, such as Migration Enabler or the Management Component, click the drop-down arrow beside
the feature on the Custom Setup dialog box:

NOTE:

● A selected feature displays a hard drive icon next to it. A red X next to it indicates features that are not selected.

● The icon next to the feature name indicates the install state of the feature. Click Help in the Custom Setup dialog

box for more information about the icons.

a. Select Entire feature will be unavailable.
b. Click Next.

5. In Ready to Change Dell EMC PowerPath 6.X.(xxbit), click Change.

6. Click Finish.

7. When prompted to reboot the host, click No to reboot later.
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Feature removal (other than the Management Component) needs reboot.

Results

If you removed multipathing support for any storage systems, complete the steps in Disconnecting redundant paths to the
storage system

PowerPath for Windows Patch removal

About this task

Uninstalling a base PowerPath package will uninstall any related patches as well. For example, uninstallation of PowerPath 6.3
will uninstall any corresponding PowerPath 6.3 patches as well.

Uninstalling a PowerPath for Windows patch using the GUI

Steps

1. If the PowerPath Administrator is running, close it.

2. Close all applications.

3. Open the Control Panel and then select Add/Remove Programs or Programs and Features.

4. Display the installed PowerPath patch you want to remove by clicking Show updates or View installed updates.

5. Select the specific PowerPath patch you want to remove, and click Remove.

6. Click Yes to remove the PowerPath patch.

7. Click Yes to restart the host.

Uninstalling PowerPath using the CLI

The command line method allows you to remove PowerPath multipathing and/or other features, such as Migration Enabler. Use
this procedure for complete PowerPath removal or for feature-specific removal.

Steps

1. Remove PowerPath.
● For a silent or unattended removal, PowerPath does not require user input.

Silent removals include the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> <Property>=<Value>"
NOTE: Silent or unattended removal errors are logged in <logfile>, the location specified in the uninstallation

command. No error message appears in the Windows PowerPath Administrator GUI.

● For an interactive removal, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile> <Property>=<Value>"

drive The drive letter, for example, C.

PowerPath_pkg_
name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is the product version. For
example, PowerPath 6.3.

uninstall_parame
ters

One or more parameters (/s, /v, /r, or /p) that are described in CLI parameters.

logfile Creates the log file where the log message is sent, for example, C:\logs\PPsetup.log. Ensure
that the specified directory exists within the specified path.

Property=Value One or more optional properties that are described under the /v parameter in CLI parameters.

The following examples provide scenarios using the silent and interactive CLI methods.
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NOTE: Use PPREMOVE=CLEAN for complete removal of PowerPath.

● Silent removal

Remove all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for EMC
storage arrays) using the silent removal method. It also disables reboot.

C:\EMCPower.X64.signed.6.x.<build>.exe /s /v"/L*v C:\logs\PPremove.log NO_REBOOT=1
PPREMOVE=CLEAN"

● Unattended removal

Removes all default PowerPath features (Multipathing, Migration Enabler, Management Component, and support for
EMC storage arrays) using the unattended uninstallation method. It also disables reboot.

Unattended installations include the /p parameter.

C:\EMCPower.X64.signed.6.x.<build>.exe /p /v"/L*v C:\logs\PPremove.log NO_REBOOT=1
PPREMOVE=CLEAN"

● Interactive removal

Removes components to support HP XP and Hitachi arrays and disables restart.

C:\EMCPower.X64.signed.6.x.<build>.exe /v"/L*v C:\Uninstall_HPXP_HDS.log NO_REBOOT=1
PPREMOVE=HPXP,HDS

● Use only in case if you encounter a problem with normal PowerPath uninstallation (interactive/silent uninstallation).

The /r parameter replaces PPREMOVE=ALL. By default, a bootstrapper log is created in %ProgramData%
\EMC\PowerPath\logs. Adding the /L*v <logfile> parameter does not create a log file when using the
PPRemoveAll utility.

C:\EMCPower.X64.signed.6.x.<build>.exe /r

2. After uninstalling, complete the steps in Disconnecting redundant paths to the storage system.

CLI parameters describes the parameters and options.

PowerPath uninstallation troubleshooting
The following table lists PowerPath uninstallation troubleshooting scenarios.

About this task

Table 1. Troubleshooting scenarios 

Problem Message Suggested action

Uninstalling PowerPath in a Boot from
SAN configuration on a host that has
Windows Server 2008 R2 or later
requires two host reboots.

PowerPath cannot disable some
of its devices because a page
file is located in a LUN
under PowerPath control or host
is configured to boot from
SAN. Under these scenarios, two
host reboots are required to
uninstall PowerPath. Click OK to
proceed, or Cancel to exit.

1. Go to Control Panel and select
Add/Remove Programs.

2. Select PowerPath.
3. Click Remove.
4. Restart the host.
5. Repeat steps 1 through 3.
6. Restart the host.

MPIO is ready to be uninstalled in a
Boot from SAN configuration.

PowerPath has prepared the
system for uninstallation. You
must restart your system
and continue with PowerPath
uninstallation.

1. Go to Control Panel and select
Add/Remove Programs.

2. Select PowerPath.
3. Click Remove.
4. Restart the host.
5. Repeat steps 1 through 3.
6. Restart the host.
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Disconnecting redundant paths to the storage system
After uninstalling PowerPath, disconnect redundant paths to the storage system.

About this task

CAUTION: Data corruption is possible if multiple paths remain on a system after PowerPath is removed.

Steps

1. In the Shut Down Windows dialog box, select Shut Down from the list and then click OK.

2. With the host shut down, disconnect the redundant cables from the HBAs to the storage system interface ports.

NOTE: SAN (fabric) configurations may have multiple logical configurations per physical connection. Ensure that no

redundant zoned paths exist.

3. Restart the host.
PowerPath is completely removed from the host.
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Managing PowerPath
This chapter contains the following sections:

Topics:

• Overview
• PowerPath Monitor
• PowerPath registration tools
• PowerPath Administrator
• Monitoring local or remote hosts with MMC
• Saving and loading Administrator settings
• Saving MMC console settings
• Deploying PowerPath with SMS
• Windows Server traybar and UAC
• Audit and error log messages

Overview
The PowerPath Administrator graphical user interface for Windows Server consists of two applications:

● PowerPath Monitor—Continuously monitors your PowerPath configuration and alerts you of status changes. The PowerPath
Monitor section provides additional information.

● PowerPath Administrator—Configures, monitors, and manages PowerPath devices. The PowerPath Administrator provides
additional information.

PowerPath Monitor
PowerPath Monitor (on the taskbar of the Windows desktop) continuously monitors the status of the PowerPath configuration.
PowerPath Monitor can be set to alert you with visual and audible cues when the status changes.

For example, if a path fails, the icon changes accordingly. Depending on the Notification settings you choose on the Options tab
of the PowerPath Admin (root node) Properties dialog box (see PowerPath Administrator online help for Windows Server),
PowerPath Monitor may:

● Sound an alarm.
● Restore the PowerPath Administrator main window.
● Flash the taskbar icon.
● Or any combination thereof.

The following table shows the taskbar icons and the status each represents.

Table 2. PowerPath Monitor taskbar icons 

Taskbar icons Status

Optimal—All configured paths are operating correctly.

Degraded—Some but not all paths have failed.

All Failed—All configured paths have failed.

5
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Table 2. PowerPath Monitor taskbar icons (continued)

Taskbar icons Status

Server Not Responding—Cannot communicate with Monitor service. This occurs if the
PowerPath Administrator Suite encountered errors during initialization.

PowerPath Unlicensed— PowerPath is unlicensed.

Reboot Pending—Restart the system for the configuration changes made to PowerPath to
take effect.

NOTE: All non-optimal monitor icons appear only if you have selected the Flash Taskbar Icon on the Options tab of the

PowerPath Admin (root node) Properties dialog box. The root node is the top-level view of the configuration and

represents the host that PowerPath manages.

Launching MMC with the PowerPath snap-in

About this task

You can use PowerPath Monitor to do the following:
● Launch Microsoft Management Console (MMC) with the PowerPath snap-in.
● Notify you of PowerPath status changes if you are running it on a local host.

NOTE: The PowerPath Administrator Monitor monitors the local host only. It does not remotely monitor the status of

another host. The icon is only present on the Windows taskbar on the host with PowerPath Administrator installed. If you

are running PowerPath for the first time on a remote host, you must start the application according to the instructions at

Monitoring local or remote hosts with MMC

Steps

● Perform one of the following steps.
○ Double-click the PowerPath Monitor icon on the Windows taskbar to launch the default MMC console with the

PowerPath Snap-in.
○ Right-click the PowerPath Monitor icon to display the following context menu options: PowerPath Administrator

(launches PowerPath Administrator) or Close Monitor (closes the PowerPath Administrator Monitor).

PowerPath registration tools
You can use the PowerPath Licensing Tool or the emcpreg command to register PowerPath and related products.

Adding a license using the PowerPath licensing tool

The Licensing Tool is used to register PowerPath and other products, from the Windows GUI.

About this task

This tool allows you to add or remove licenses. For more information, see the online help (press F1) or launch the help file,
EMCLicTool.chm, from the PowerPath software CD or the \help directory.

Steps

● The Licensing Tool is displayed during PowerPath installation.

To manage licenses, you can launch the tool by selecting Start > All Programs > Dell EMC PowerPath Licensing Tool.
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Adding a license using the emcpreg command

The emcpreg command facilitates scripting options and is the only way to manage licenses with the Windows Server Core. The
emcpreg command is supported with all supported Windows platform versions.

Steps

● Add a license.

emcpreg -add <key>
Where <key> is the product license key.

The PowerPath Family CLI and System Messages Reference provides additional information.

PowerPath Administrator
The PowerPath Administrator is a graphical user interface for configuring, monitoring, and managing PowerPath devices.
The PowerPath Administrator continuously monitors a multipath storage-system environment and automatically updates the
configuration information that appears. You can use PowerPath Administrator to set up and change your device configuration
and manage physical and logical path components.

The PowerPath Administrator displays a hierarchical representation of paths, logical devices, and HBAs. PowerPath
Administrator displays the components of a PowerPath system as objects. PowerPath Administrator icons represent the
PowerPath objects in your configuration. The type of icon reflects the state or status of the particular object selected. Table 6
and Table 7 display PowerPath Administrator icons.

PowerPath Administrator panes

As part of MMC, the PowerPath Administrator has two panes:

● The scope pane displays PowerPath objects in a hierarchical list that can be expanded or collapsed.
● The result pane provides a view of configuration statistics for PowerPath objects selected in the scope pane.

Accessing the PowerPath Administrator device properties

You can access most of the PowerPath Administrator functions through the tabs available in the device Properties dialog box.

About this task

PowerPath Admin (root node) properties — Use this to:

● Show root node details
● Set local or remote host options
● Set error notification options
● Set Auto-Restore
● View array management information
● Set the path latency options
● Manage the autostandby feature options
● Manage persist_path-info option

NOTE: The root node is the top-level view of the configuration and represents the host that PowerPath manages. The

Root Node Properties dialog box contains the Details, Computer, and Options tabs. (The Computer tab is present only

when you are connected to a remote host).

● Storage array properties—Show storage array details. To display this tab, select a storage array, right-click, and click
Properties.

● Storage array port properties—Show storage array port details. To display this tab, select a storage array port, right-click,
and click Properties.

● Adapter properties—Show adapter details and change modes on the adapter. To display this tab, select an adapter, right-
click, and click Properties.
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● Disk properties—Show disk details, change modes on the disk, and change load-balancing policies and priorities. To display
this tab, select a disk, right-click, and click Properties.

● Path properties—Show path details and change the mode of a path. To display this tab, select a path, right-click, and select
Properties.

NOTE: The previous examples illustrate the most common PowerPath Administrator functions. The PowerPath

Administrator online help for Windows Server provides complete information on using all the PowerPath Administrator

functions.

Steps

● Right-click the Dell EMC PowerPathAdmin root node and then select Properties.

Icons: standard, unlicensed, and unknown conditions

The following table shows icons for standard, unlicensed, unknown, and mismatched states. Standard icons represent a
configuration in which PowerPath is optimal.

Table 3. Icons on the PowerPath administrator 

Object Standard Icon Unlicensed
Icon

Unknown Icon Mismatched
Icon

Root Node—Graphical representation of the host and
top level view of your configuration.

N/A

Storage Array—An attached storage system that
provides logical devices which are managed by
PowerPath.

N/A

Storage Array Port—Identifies a port within a specific
storage array that provides I/O paths to the logical
devices.

N/A

Disk—A logical device managed by PowerPath.
Logical devices are disk devices presented by the
storage system.

N/A

Adapter—A device that provides an interface
between the SCSI or Fibre Channel bus and the
computer I/O bus. An adapter can have multiple paths
associated with it.

N/A

Path—The logical or physical I/O path from the host
to the storage system, including the HBA, cable, and
interface port.

NOTE: The online help provides more information on icons and their meaning.

Icons: known failure conditions

When a path fails, the failure propagates through other PowerPath Administrator objects. These objects are displayed in a
hierarchy in the scope pane and result pane. These known failure icons represent configurations that are less than optimal.

Degraded PowerPath objects are represented by a red slash through the standard object icon. (Because a path is either open or
closed, the path icon is never shown as degraded.) Failed PowerPath objects are represented by a red X through the standard
object icon.

The definition of degraded and failed status depends on the context shown in the following table. For example, an unlicensed
version of PowerPath with degraded or failed paths displays icons that combine elements of both the unlicensed and degraded
icons. Unless specified otherwise, all icons display in both the summary and details panes.
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Table 4. Icons of known PowerPath failure conditions 

Object Degraded Icon Failed Icon Unlicensed and
Degraded Icon

Unlicensed and Failed
Icon

Root
Node

PowerPathAdministrator is
identifying a degradation
within the managed
environment.

 PowerPath
Administrator is in a failed
state.

 PowerPath is
unlicensed and identifying
a degradation within the
managed environment.

 PowerPath
Administrator is
unlicensed and in a failed
state.

Storage
Array

 One or more (but
not all) paths to the
storage array have failed or
are in a degraded state.

 All paths to the
specific array have failed.
This array is not available.

 PowerPath
Administrator is
unlicensed. One or more
(but not all) paths to the
array have failed or are in
a degraded state.

 PowerPath
Administrator is
unlicensed. All paths to
the specific array have
failed. This array is not
available.

Storage
Array Port

 One or more (but
not all) paths to the
storage array port have
failed or are in a degraded
state.

 All paths to the
specific array port have
failed. This array port is not
available.

 PowerPath
Administrator is
unlicensed. One or more
(but not all) paths to the
array port have failed or
are in a degraded state.

 PowerPath
Administrator is
unlicensed. All paths to
the specific array port
have failed. This array
port is not available.

PowerPat
h Device

 One or more (but
not all) paths to the disk
device have failed.

 All paths to the
specific disk device have
failed. This disk is not
available.

 PowerPath
Administrator is
unlicensed. One or more
(but not all) paths to the
disk device have failed.

 PowerPath
Administrator is
unlicensed. All paths to
the specific disk device
have failed. This disk is
not available.

Adapter

 One or more (but
not all) adapters have
either failed or degraded.
Displays in the Adapters
folder in the scope pane.
One or more (but not all)
paths have failed on the
specific adapter.

 All paths on this
adapter have failed.

 PowerPath
Administrator is
unlicensed. One or more
(but not all) paths have
failed on the specific
adapter.

 PowerPath
Administrator is
unlicensed. All paths on
this adapter have failed.

Path Not applicable

 One or more of the
hardware components that
make up the path has failed;
therefore, the entire path
failed.

Not applicable

 PowerPath
Administrator is
unlicensed, and one
or more of the
hardware components
that comprise the path
has failed; therefore, the
entire path fails.

Undefined SP conditions

The following icons represent a rare condition on active/passive arrays, including VNX OE and CLARiiON, that produce a double
link control card (LCC) failure. If you see these icons, the LCC fault light on the VNX OE or CLARiiON array should be amber.
Refer to the VNX OE or CLARiiON documentation for troubleshooting information, or contact Customer Support for information
on replacing an LCC.
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Table 5. Icons of undefined SP PowerPath failure conditions 

Standard Icon Degraded Icon Failed Icon Unlicensed Icon Unlicensed and
Degraded Icon

Unlicensed and
Failed Icon

 The
CLARiiON link
control cards
(LCC) have failed.
The SP owning the
disk is unknown
and the disk is
unavailable.

 The
CLARiiON link
control cards
(LCC) have failed.
The SP owning the
disk is unknown
and one or more
(but not all) paths
to the disk device
has failed. The disk
is unavailable.

 The
CLARiiON link
control cards
(LCC) have failed.
The SP owning the
disk is unknown
and all paths to
the disk device has
failed. The disk is
unavailable.

 The
PowerPath
Administrator is
unlicensed and
the CLARiiON
link control cards
(LCC) have failed.
The SP owning the
disk is unknown
and the disk is
unavailable.

 The
PowerPath
Administrator is
unlicensed and
the CLARiiON
link control cards
(LCC) have failed.
The SP owning the
disk is unknown
and one or more
(but not all) paths
to the disk device
has failed. The disk
is unavailable.

 The
PowerPath
Administrator is
unlicensed and
the CLARiiON
link control cards
(LCC) have failed.
The SP owning the
disk is unknown
and all paths to
the disk device has
failed. The disk is
unavailable.

Monitoring local or remote hosts with MMC
With MMC and the PowerPath Snap-in, you can monitor a local host or a remote host.

About this task

Local administration— PowerPath Administrator is installed on the local host by default. The installation process provides
a preconfigured .msc file to launch the Microsoft Management Console (MMC). Once PowerPath is installed, you can use
PowerPath to monitor the local host immediately.

Remote administration—Part 2: Adding the PowerPath Administrator snap-in (Remote) provides additional information on how
to add the PowerPath Snap-in to monitor a remote host with PowerPath installed.

Steps

● Launch MMC with the PowerPath Snap-in.

Select Start > All Programs > EMC > PowerPath > PowerPathAdmin.

Example

NOTE: The path starts the PowerPath Snap-in and the MMC console on the local host with no other action required.

However, there may be scenarios in which you need to add the PowerPath Snap-in to a new MMC console. For example,

you may want to create another instance of PowerPath Administrator on the local host or you may have deleted the

PowerPath Snap-in and want to add it again. Part 2: Adding the PowerPath Administrator snap-in (local) provides additional

information on how to add the PowerPath Snap-in to the MMC console to monitor a local host.

Setting a local host option

Adding the PowerPath snap-in to MMC and monitoring a local host is a two-part procedure.

Part 1: Opening the MMC

Steps

1. Click Start.

a. In the Start Search text box, type mmc.

b. In the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).
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NOTE: 32-bit is only available after product qualification has been requested from Dell EMC Online Support.

3. Click OK.
An MMC Console appears. The MMC title bar displays Console1. Within this pane is the Console Root. Initially this folder
is empty. However, once the snap-in is added, this folder will contain the PowerPath Administrator (and any other added
snap-ins) and is displayed as expandable icons under the Console Root folder.

Part 2: Adding the PowerPath Administrator snap-in (local)

Steps

1. From the MMC console, select File > Add/Remove Snap-in.

2. Select PowerPath Administration and click Add.

3. Select Local Computer.

4. Click Finish.

5. In the Add/Remove Snap-in dialog box, click OK.
PowerPath Administrator is now added to the MMC console.

Results

You can now use PowerPath Administrator to configure, manage, and monitor PowerPath devices. Once you have changed the
configuration, save the configuration. Saving a configuration provides additional information.

Setting a remote host option

Adding the PowerPath snap-in to MMC and monitoring a remote host is a two-part procedure.

Part 1: Opening the MMC

Steps

1. Click Start.

a. In the Start Search text box, type mmc.

b. In the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

NOTE: 32-bit is only available after product qualification has been requested from Dell EMC Online Support.

3. Click OK.
An MMC Console appears. The MMC title bar displays Console1. Within this pane is the Console Root. Initially this folder
is empty. However, once the snap-in is added, this folder will contain the PowerPath Administrator (and any other added
snap-ins) and is displayed as expandable icons under the Console Root folder.

Part 2: Adding the PowerPath Administrator snap-in (Remote)

Steps

1. From the MMC console, select File > Add/Remove Snap-in.

2. Select PowerPath Administration and click Add.

3. Select Another Computer.

4. Type the computer name or browse for the remote computer.

5. In the Browse for Computer dialog box, click OK.

6. Type your User Name, Domain Name, and Password.

7. Click Finish.
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NOTE: The User Name, Domain Name, and Password fields are subsequently available for editing from the root node

Properties page if you are using MMC to monitor a remote host. The section "Set Remote Host Options" in the

PowerPath Administrator online help provides additional information.

8. In the Add Standalone Snap-in dialog box, click Add to add another snap-in or click Close.

9. In the Add/Remove Snap-in dialog box, click OK.
PowerPath Administrator is now added to the MMC console.

Saving and loading Administrator settings

About this task

You can use PowerPath Administrator to configure, manage, and monitor PowerPath devices. The first time you run PowerPath
Administrator, there is a default configuration. If you make changes, you can save them to a configuration file. The file records
the serial numbers, mode, policy, and priority for each configured path. You can also load the last known configuration or a
previously saved file.

NOTE: PowerPath configuration files are distinct from the PowerPath management pack Microsoft Management Console

(MMC) configuration files. If you close the MMC window, MMC prompts you to save the MMC settings. These settings are

not the same as the PowerPath Administrator settings. Saving the MMC console settings does not save your PowerPath

configuration changes. These changes will be lost unless you complete the following procedure.

Saving a configuration

Save the current PowerPath Administrator settings.

About this task

NOTE: Saving the configuration may override an existing configuration file. Provide a unique file name and use the Save As

option to avoid overriding an existing configuration file.

Steps

● Perform one of the following steps:
○ Type powermt save [file=<pathname>]
○ In PowerPath Administrator, right-click the root node and select All Tasks > Save Config as. Specify a file name and

click Save.
● Save the configuration for reboot.

Loading a configuration

You can load the last known reboot state or a previously saved configuration file.

About this task

To load the last known reboot state, right-click the root node and select All Tasks > Load Reboot Config.

Steps

1. In the scope pane, select the PowerPath Admin root node.

2. To load a previously saved PowerPath configuration, right-click the root node and select All Tasks > Load Config File.
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Saving MMC console settings
The MMC console enables you to display the PowerPath Snap-in data in many ways. If you change your MMC console
configuration (for example, if you resize columns, change column displays, or change column sort order), you may want to save
these new MMC console settings.

If you close the MMC console itself, or the PowerPath Snap-in within the MMC console, MMC prompts you with the following
message:

Save console settings to <filename>.msc? 

Click Yes to save the latest console settings. By default, the MMC console settings are saved as console1.msc in the folder:

%SystemDrive%\Programs\Administrative Tools
You can save the console settings anytime with the Console, Save menu option in the MMC console. To save the file with a
different name or to a different location, go to MMC Console > Save As.

Deploying PowerPath with SMS
PowerPath has been qualified with the Systems Management Server (SMS) software from Microsoft, which allows remote
management of large groups of Windows-based systems. SMS allows you to remotely manage patches, distribute software,
deploy operating systems, and perform software and hardware inventories.

Steps

1. Create a PowerPath package in SMS.

2. Create a program for that PowerPath package.

3. Assign distribution points to that package.

4. Advertise the package to target clients by defining a collection.

See the Microsoft SMS product documentation for detailed instructions.

Windows Server traybar and UAC
The traybar monitor program communicates to the PowerPath service where it previously communicated directly with the kernel
driver. This means that if the PowerPath service is disabled or fails to start, the traybar monitor will not function and an error
displays.

For those tasks that require administrator privileges, you receive the elevated prompt when:

● Opening the GUI from the traybar monitor.
● Launching admin GUI from a program group.
● Starting the license tool.

When the license tool is launched from the Installation program, you do not receive an elevation prompt.

NOTE: The above information is valid only for built in administrator accounts and any accounts which are part of the

administrator group, if UAC is turned on.

Audit and error log messages
The PowerPath Family CLI and System Messages Reference on Dell EMC Online Support describes audit logging, including
instructions for setting up logging in the environment. It also lists error messages, descriptions, and suggested corrective action.
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PowerPath features for PowerMax array
PowerPath for Windows 6.3 supports the following features when the host is connected to a PowerMax array running
microcode 5978 and above.

Topics:

• PowerPath Auto Host Registration
• PowerPath Device IO Statistics
• PowerPath Device in Use Reporting
• FX Licensing

PowerPath Auto Host Registration
This section provides information on the PowerPath Auto Host Registration feature.

Overview

PowerPath Auto Host Registration is a feature that enables a host to be registered with PowerMax array running microcode
5978 and above. This feature makes it easier to configure storage for a new host from an array.

Initial Registration and Storage Configuration

This section provides information about the initial registration and storage configuration of the host with a storage array.

When a new host is zoned to a PowerMax array, virtual devices that are known as LUNZ devices are presented to the host, one
per logical path. These devices are automatically configured in PowerPath. However, powermt display does not show these
devices. Once the LUNZ devices are configured in PowerPath, registration commands are automatically sent on each path to
the array through the LUNZ devices.

The registration commands contain information such as hostname, UUID, OS version, and PowerPath version. On receipt of
these registration commands, the PowerMax array creates a host record and all the WWNs of the host's HBAs are grouped
under this record. If AUTO IG creation feature is enabled on the array, then an Initiator Group is created automatically.

After the Initiator Group is created (automatically or manually), then other entities such as, the Storage Group, Port Group, and
Masking view can be created to configure data LUNs for the host.

Mode of operation

PowerPath Host Registration works in the following two modes:

Automatic

PowerPath Host Registration is configured automatically in the following scenarios:
● On PowerPath start or host reboot, the registration is attempted within 5 minutes.
● Once every 24 hours after the initial registration, registration is again attempted. This helps in the array being aware that the

host is active.
● If any of the host information such as the hostname changes, then a registration is attempted within 60 minutes.
● If the host is zoned to a new PowerMax array, then the registration is attempted within 5 minutes.

6
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Manual

The powermt update host_registration command can be run at any time to send registration to all connected
PowerMax arrays. This information is useful in scenarios where the hostname is changed and the array needs to be updated
immediately.

Settings

This section provides information about the settings that you need to configure the PowerPath Auto Host Registration.

PowerPath Auto Host Registration is enabled by default for Symmetrix arrays. This information can be seen with the powermt
display options command.

[~]# powermt display options

        Show CLARiiON LUN names:      true

        Path Latency Monitor: Off
        Persist Path Information: On

        Performance Monitor: disabled
        Interval           : 1 min(s)

        Autostandby:  IOs per Failure (iopf): enabled
                      iopf aging period     : 1 d
                      iopf limit            : 6000

        IP Address for Host Registration: default

        Storage
        System Class  Attributes
        ------------  ----------

        Symmetrix     periodic autorestore = on
                      reactive autorestore = on
                      status = managed
                      proximity based autostandby = off
                      auto host registration = enabled
                      app finger printing = enabled
                      device to array performance report = enabled
                      device in use to array report = enabled
This setting can be changed with the following powermt set command:

powermt set auto_host_registration={on|off} class=<class>
There is also a setting on the PowerMax array which enables or disables accepting host registration commands. If the host
registration is disabled on the array, but enabled on the host, registration is not attempted.

Viewing Host Registration

The Solutions Enabler software is used to check the details of the host from the array after registration. In this PowerPath
release, virtual machine details are not sent in the registration commands and hence the array does not display any virtual
machine details even if the host has Hyper-V virtual machines. If cluster software is configured in the host, the cluster software
details are sent in the registration commands.

symcfg.exe -sid 1413 list -ppreg -host WQ212038

Symmetrix ID     : 000197801413

    Host Name:              WQ212038
    OS Version:             Windows 2016
    OS Revision:            Datacenter Build 14393
    Hardware Vendor Name:   Dell Inc.
    PowerPath Version:      6.3.0
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    PowerPath Patch Level:  00.00-231
    PowerPath License Info: XXXX-XXXX-XXXX-XXXX-XXXX-XXXX
    Host Registration Time: 10/22/2018 22:07:00
    Host Connectivity type: FC
    Cluster Info:
       Cluster Name: WIN632K16
       Cluster Node Name: WQ212038
    WWNs:
       (1): 21000024FF31800F
       (2): 21000024FF31800E
    VMs:
 

PowerPath Device IO Statistics
This section provides information on the PowerPath Device IO Statistics feature.

Overview

The PowerPath Device IO Statistics feature provides host IO performance collection and reporting to PowerMax microcode
5978 and above. These statistics are collected per PowerPath managed PowerMax device and reported to array at one minute
intervals.

Settings

This section provides information about the settings that you need to configure the PowerPath Device IO Statistics.

PowerPath Device IO Statistics is enabled by default for PowerMax arrays. This information can be seen with the powermt
display options command.

 # powermt display options

        Show CLARiiON LUN names:      true

        Path Latency Monitor: Off

        Persist Path Information: On

        Performance Monitor: disabled
        
        Autostandby:  IOs per Failure (iopf): enabled
                      iopf aging period     : 1 d
                      iopf limit            : 6000

        IP Address for Host Registration: default

        Storage
        System Class  Attributes
        ------------  ----------

        Symmetrix     periodic autorestore = on
                      reactive autorestore = on
                      status = managed
                      proximity based autostandby = off
                      auto host registration = enabled
                      app finger printing = enabled
                      device to array performance report = enabled
                      device in use to array report = enabled

This setting can be changed with the following powermt set command:

#powermt set device_perf_to_array_report={on|off} [class=<class>|all]

46 PowerPath features for PowerMax array



Viewing PowerPath Device IO Statistics

PowerMax populates these performance statistics in Unisphere providing a single pane of display with both host and array level
statistics.

PowerPath Device in Use Reporting
This section provides information on the PowerPath Device in Use Reporting feature.

Overview

PowerPath Device in Use Reporting feature provides a way to report by PowerPath to PowerMax running microcode version
5978 and above on PowerPath managed devices.

The device usage statistics reported to array are used by storage administrators to know LUN usage on hosts, in array capacity,
and resource planning. PowerPath sends details such as if the device is mounted and name of the process that used the device
in the preceding 24 hours to the array.

Settings

This section provides information on the settings that you need to configure the PowerPath Device in Use.

PowerPath Device in Use feature is enabled by default for PowerMax. This can be seen with the powermt display
options command.

#powermt display options

        Show CLARiiON LUN names:      true

        Path Latency Monitor: Off

        Persist Path Information: On

        Performance Monitor: disabled

        Autostandby:  IOs per Failure (iopf): enabled
                      iopf aging period     : 1 d
                      iopf limit            : 6000

        Storage
        System Class  Attributes
        ------------  ----------

        Symmetrix     periodic autorestore = on
                      reactive autorestore = on
                      status = managed
                      proximity based autostandby = off
                      auto host registration = enabled
                      app finger printing = enabled
                      device to array performance report = enabled
                      device in use to array report = enabled
This setting can be changed with the following powermt set command:

#powermt set dev_inuse_to_array_report={on|off} [class=<class>|all]

Viewing PowerPath Device in Use information

You can view the PowerPath Device in Use information as follows:

bash-4.2# ./symdev list -ppi -dev 02E2 -sid 413
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Symmetrix ID     : 000197801413

        P O W E R P A T H  D E V I C E  S T A T U S
Device Last I/O Time      Mounted Hostname         Process name
------ -----------------  ------- ---------------- ----------------
002E2  10/23/18 03:43:27  Yes     WQ212038         
bash-4.2#

FX Licensing
PowerPath is licensed by acquiring a license key and entering it with the emcpreg utility or the PowerPath licensing tool. If a
PowerMax array is purchased with an FX bundle, all PowerPath hosts attached to it is automatically licensed by attaching data
LUNs to the host.

The number of hosts that can thus be licensed is limited to 75 hosts per FX bundle. PowerPath is fully licensed not just
for the PowerMax LUNs and paths, but for all LUNs and paths from other array types as well. PowerPath Migration Enabler
functionality is also available through the FX bundle.

All powermt commands work without generating any license-related warnings. To verify that the host is licensed through FX,
you can use any of the following commands:

● [~]# powermt check_registration

Host is licensed through FX array.
● [~]# emcpreg -l

Host is licensed through FX array.
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PowerPath in an MSCS cluster
This chapter contains the following sections:

Topics:

• Installing PowerPath and MSCS
• Integrating PowerPath into an existing MSCS cluster

Installing PowerPath and MSCS
If you are installing PowerPath and MSCS for the first time, install PowerPath first, and then install MSCS. Installing PowerPath
first avoids disruption of cluster services at a later time. The Microsoft MSCS documentation provides complete information on
planning, configuring, managing, and troubleshooting MSCS.

After installing PowerPath and before installing MSCS, run the emcphostid check to check for host conflicts. If the host
IDs are not unique, run the emcphostid set command to set a unique host ID.

NOTE: All nodes in a cluster must have the same version of PowerPath installed. Clusters with different hosts running

different versions of PowerPath will not be supported.

Integrating PowerPath into an existing MSCS cluster
You can integrate PowerPath into an existing MSCS cluster, without shutting down the cluster, if there is close coordination
between the nodes and the storage system.

Each node in a cluster can own a distinct set of resources. Node A is the primary node for its resources and the failover node
for node B resources. Conversely, node B is the primary node for its resources and the failover node for node A resources. The
Microsoft MSCS documentation provides complete information on planning, configuring, managing, and troubleshooting MSCS.

NOTE: After installing PowerPath on the cluster, any testing involving node failover by disconnecting all cables for a LUN

or otherwise disrupting the path between the active host and the array logs an event message in Windows. These event

messages will indicate hardware or network failure and possible data loss. If working correctly, the cluster will failover to a

node with an active path and you can ignore the messages from the original node as logged in the event log. You should

check the application generating I/O to see if there are any failures. If there are none, everything is working normally.

The following procedure describes how to install PowerPath on a two-node cluster. You can also install PowerPath on clusters
with more than two nodes. In these cases, the appropriate action is noted where applicable for clusters with more than two
nodes.

To add PowerPath to an existing MSCS cluster (with MSCS running on both nodes), follow these procedures:

● Moving all resources to node A
● Installing PowerPath on node B
● Configuring more paths between the storage system and node B
● Moving all resources to node B
● Installing PowerPath on node A
● Configuring more paths between the storage system and node A
● Returning node A resources to node A
● Checking for host ID uniqueness (optional)

7
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Moving all resources to node A

Steps

1. Start the Windows Server Failover Cluster Manager Console.

2. Select all groups owned by node B.

3. Move the resources to node A.

4. Pause node B to keep the node from participating in the cluster during PowerPath installation.

Installing PowerPath on node B

Steps

● Install PowerPath on node B.

In a cluster with more than two nodes, install PowerPath on these other nodes. For example, in a four-node cluster, replace
node B with nodes B, C, and D as shown in the section Moving all resources to node A.

Configuring more paths between the storage system and node B

Steps

1. If necessary, reconfigure the storage system so its logical devices appear on multiple ports.

2. If necessary, install additional HBAs on node B.

3. Connect cables for new paths between node B and the storage system.

4. Get the host ID.

emcphostid get
Make note of the returned PowerPath host ID for this node.

5. To resume node B, right-click node B and then click Resume.

NOTE: The check and the possible correction need to be performed before resuming the node.

In a cluster with more than two nodes, configure additional paths between the storage system and these other nodes. In
case this is node C, D, and later (that is, this is not the first installation node) and the host ID returned by emcphostid
get is not unique (matches to ID of one of the previous nodes in this cluster), then manually change to any arbitrary value
unique for this cluster using emcphostid set.

Moving all resources to node B

Steps

1. In the left pane of the Cluster Administrator window, select all groups.

2. Move the resources to node B.

In a cluster with more than two nodes, move all resources to any of the remaining nodes. For example, in a four-node cluster,
replace node B with any combination of nodes B, C, and D to which you want to move resources.

3. Pause node A.

Installing PowerPath on node A

Steps

● Install PowerPath on node A.
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Configuring more paths between the storage system and node A

Steps

1. If necessary, configure the storage system so its logical devices appear on multiple ports.

2. If necessary, install additional HBAs on node A.

3. Connect cables for new paths between node A and the storage system.

4. Ensure the host IDs are unique on the cluster.

emcphostid get
If the returned ID is not unique (matches to ID of one of the previous nodes in this cluster) then manually change to any
arbitrary value unique for this cluster using emcphostid set.

5. Resume node A.

The check and the possible correction needs to be performed before resuming the node.

Returning node A resources to node A

Steps

1. Using the Windows Server Failover Cluster Manager, select all groups previously owned by node A.

2. Move the resources back to node A.

Checking for host ID uniqueness (optional)

Steps

● If emcphostid get calls, checks and possible corrections were performed before every node was resumed, then remove
host IDs that are not unique.
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PowerPath in a Veritas Cluster Server
This chapter contains the following sections:

Topics:

• Installing PowerPath and VCS
• Installing PowerPath into an existing VCS environment

Installing PowerPath and VCS
Follow this procedure when installing PowerPath and Veritas Cluster Server (VCS) for the first time. The order matters.

Steps

1. Install PowerPath.

2. Install Veritas Cluster Server (VCS).

Results

Installing PowerPath first avoids disruption to the cluster services at a later time. The Veritas Storage Foundation High
Availability (SFHA) documentation provides complete information on planning, configuring, managing, and troubleshooting VCS.

NOTE: All nodes in a cluster must have the same version of PowerPath installed. Clusters with different hosts running

different versions of PowerPath will not be supported.

Installing PowerPath into an existing VCS
environment

Prerequisites

CAUTION: Ensure that you follow these steps to manage the cluster environment. Failure to do so can result in

data corruption and data loss. Refer to the Veritas Cluster Server (VCS) documentation on how to configure and

manage VCS in a clustered environment.

Steps

1. In the Cluster Administrator window, ensure that all resources are on the primary node in the cluster.

When the cluster resources are on the primary node, the ClusterService in the Status View dialog box appears as online.

2. From the navigation pane on the left, right-click ClusterService and select Disable.

This disables the secondary node in the VCS configuration.

3. Install PowerPath on the secondary node.

Follow the procedures in Installation procedures

4. Get the host ID.

emcphostid get
Make note of the returned PowerPath host ID for this node.

NOTE: If this is not the first installation node and the returned host ID is not unique, change the host ID to any arbitrary

value that is unique on the cluster using the emcphostid set command. You must perform the check and any host

ID corrections before resuming the node.

8
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5. After installation and restart of the secondary node, right-click ClusterService and then select Enable to re-enable the
node in the VCS configuration.

6. Right-click ClusterService, select Switch to, and then select the secondary node to move all cluster resources over to the
secondary node.

7. Display the devices are in the BasicGroup and RAW group.

vxdisk list
The proper DiskType and DiskGroup information displays.

8. Once the resources are available on the secondary node:

a. Run vxassist rescan.

b. Verify that the disks are now in the proper disk group and show MBR.

vxdisk list
If there are additional nodes in the cluster configuration, repeat for each node.

Displaying DiskType and DiskGroup information

The vxdisk list command displays DiskType as RAW instead of MBR and all disks appear to be in the default DiskGroup
‘BasicGroup’ after the installation of PowerPath.

About this task

C:\Documents and Settings\Administrator>vxdisk list
Name     MediaName Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID     
P#C#T#L#
Harddisk0          BasicGroup MBR     156327    127327     Uninitialized DISKS@lhclu056 
P0C0T0L0
Harddisk1   Disk1   dg1       RAW     10236     0          Imported      DGC0           
P2C0T0L0
Harddisk2   Disk2   dg1       RAW     10236     0          Imported      DGC0           
P2C0T1L1
Harddisk3   Disk3   dg1       RAW     10236     5118       Imported      DGC0           
P2C0T0L2
Harddisk4   Disk4   dg1       RAW     10236     5118       Imported      DGC0           
P2C0T1L3
 
C:\Documents and Settings\Administrator>vxassist rescan
Successfully rescanned

Note: Notice disk now properly show diskstyle as MBR

C:\Documents and Settings\Administrator>vxdisk list
Name      MediaName  Diskgroup  DiskStyle Size(MB) FreeSpace(MB) Status EnclosureID   
P#C#T#L#
Harddisk0            BasicGroup  MBR      156327   127327 Uninitialized DISKS@lhclu056 
P0C0T0L0
Harddisk1   Disk1     dg1        MBR      10236    0          Imported      DGC0         
  P2C0T0L0
Harddisk2   Disk2    dg1         MBR      10236    0          Imported      DGC0         
  P2C0T1L1
Harddisk3   Disk3    dg1         MBR      10236    5118       Imported      DGC0         
  P2C0T0L2
Harddisk4   Disk4    dg1         MBR      10236    5118       Imported      DGC0         
  P2C0T1L3

Steps

1. Disable the primary node in the Veritas Cluster Server (VCS) configuration and install PowerPath as described in Configuring
PowerPath

2. After installing PowerPath, restart the primary node.

3. If the host IDs are not unique, set unique host IDs.

emcphostid set
4. Re-enable the node in the VCS configuration.
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5. Move all cluster resources over to the primary node.

6. Once the resources are available, run vxassist rescan.
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WHQL Certification
This appendix contains the following section:

Topics:

• WHQL-certified driver

WHQL-certified driver
On Windows Server, the Dell EMC PowerPath driver is WHQL-certified. To view the PowerPath drive signature:

1. Select Start > Control Panel > System.
2. Click Device Manager.
3. Expand the Storage controllers node.
4. Right-click EMS device busand then select Properties.
5. Click Driver > Driver Details to see the driver signature information.

When the driver is signed, the field contains information about the organization that signed the driver.

A
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Files changed by PowerPath
This appendix contains the following section:

Topics:

• Files created by PowerPath installation

Files created by PowerPath installation
The following files are added when PowerPath is installed on 64-bit hosts. If you do not install to the default locations during
PowerPath installation, these file locations can change. Hence <Install directory> is denoted as a variable in the following
sections.

NOTE: All driver files (.sys, .cat, and .inf) are copied to the internal system directories by the operating system when

they are installed.

<Install directory>\PowerPath

● db_recover.exe
● db_recover.exe.intermediate.manifest
● difxapi.dll
● EmcAdminProxy.dll
● EmcAdminSvr.exe
● EmcLicTool.exe
● EmcLicTool_CHS.dll
● EmcLicTool_DEU.dll
● EmcLicTool_ESP.dll
● EmcLicTool_FRA.dll
● EmcLicTool_ITA.dll
● EmcLicTool_JPN.dll
● EmcLicTool_KOR.dll
● EmcLicTool_PTB.dll
● emcphostid.exe
● EmcpLogMsgs.dll
● EmcpMgmtComp.exe
● EmcPowerPathAdmin.dll
● EmcPowMon.exe
● EmcPowPN22.dll
● EmcPowRes.dll
● EmcPowSrv.exe
● EmcpPerfmonPmiPrvdr.dll
● emcpreg.exe
● EmcpSvcErr.dll
● emcp_lic_rtl.dll
● Emcp_mpapi_rtl.dll
● emcp_mp_rtl.dll
● emcp_serv_rtl.dll
● Emc_PowerPath_Console.msc
● libdb51.dll
● libdb51.dll.intermediate.manifest

B
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● logcon.exe
● ManagementComp_Config.exe
● mpaa.excluded
● mpaa.lams
● powerkmd.exe
● powermig.exe
● powermt.exe
● powerpath.man
● PowMigSrvc.exe
● ppinstall.exe
● pthreadVC2.dll
● server.pem

<Install directory>\EMC\PowerPath\Drivers

● emcpbase.cat
● emcpbase.inf
● emcpbase.sys
● emcpclass.cat
● emcpclass.inf
● emcpclass.sys
● EmcpCoinst30.dll
● emcpdm.cat
● emcpdm.inf
● emcpdm.sys
● emcpdsm.cat
● emcpdsm.inf
● emcpdsm.sys
● emcpgpx.cat
● emcpgpx.inf
● emcpgpx.sys
● emcpmpx.cat
● emcpmpx.inf
● emcpmpx.sys

<Install directory>\EMC\PowerPath\EULA

● EULA.rtf

Windows\Help

● EmcLicTool.chm
● EmcLicToolCHS.chm
● EmcLicToolDEU.chm
● EmcLicToolESP.chm
● EmcLicToolFRA.chm
● EmcLicToolITA.chm
● EmcLicToolJPN.chm
● EmcLicToolKOR.chm
● EmcLicToolPTB.chm
● EmcPowerPathAdminMMC.chm

Files changed by PowerPath 57



Windows\Cluster

● ppme.dll

%ALLUSERSPROFILE%\EMC\PowerPath

● bootstrapper_*.log
● msi_*.log
● ppinstall_*.log
● vcredist_<platform>_*.log
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Configuration and parameters
This appendix contains the following sections:

Topics:

• Check NetApp storage array report_scsi_name setting
• Upgrade from Dell SCOS version 7.2.x to Dell SCOS version 7.3.x and later for Live Volumes
• CLI parameters and properties

Check NetApp storage array report_scsi_name
setting
PowerPath reports NetApp ID in powermt output and in user interface only if the Report SCSI Name String Inquiry Descriptor
setting is enabled for the initiator group through which host is connected to LUNs.

Prerequisites

Steps

1. Check the current value of the setting.

igroup show -v <initiator group name>
For example,

system1> igroup show -v <initiator group name>
<Initiator group name> (FCP):
OS Type: windows
Member: 10:00:00:00:c9:ac:58:ec (logged in on: vtic)
Member: 10:00:00:00:c9:ac:58:ed (logged in on: vtic, 1b)
UUID: 4e4eb665-fff8-11e2-98b7-123478563412
ALUA: Yes
Report SCSI Name in Inquiry Descriptor: Yes

2. Enable report_scsi_name.

igroup set <initiator group name> <report_scsi_name> yes
For a NetApp HA pair, the following property settings must be set for an initiator group before installing PowerPath:

● The report_scsi_name property must be enabled (set to yes) for both controllers of the pair.

● The ALUA property, set using the igroup command must be the same for two controllers of the pair, that is, it should
either be yes or no for both the controllers.

NOTE: PowerPath is supported only with ALUA mode of operation for NetApp initiator groups. For example, igroup
set <initiator group name> alua yes or igroup set <initiator group name> alua no

Upgrade from Dell SCOS version 7.2.x to Dell SCOS
version 7.3.x and later for Live Volumes
PowerPath 6.4 supports Dell SCOS 7.3.x.
● For existing live volumes, if Update ALUA optimized option is chosen for existing live volumes, remove the paths one by one

and add them back to detect their new ALUA state.

C
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● For all live volumes, in order to view the correct storage interfaces for remote array paths, enable the Update ALUA
optimized option.

● If the server has a mix of live volumes with and without Update ALUA optimized option, the live volumes may show different
storage interfaces. The powermt set port_mode may not work as expected in this case.

CLI parameters and properties
Displays the full list of all available installation and removal CLI parameters and properties. Parameters and properties can be
install or removal specific as identified.

Parameters

/s Suppresses installation and removal dialog boxes. Indicates a quiet installation and removal (no user
interaction).

/v Directs installation to pass the specified string (enclosed in quotes) to the Microsoft Installer (MSI). For
example, /v <property>=<value>. Where <Property> and <Value> descriptions follow.

/p Unattended installation and removal that does not require any user interaction, but will have installation
progress bar shown. For example,

For example, during installation:

<Drive>:\<PowerPath_pkg_name> /p /v"NO_REBOOT=1"

For example, during removal:

<Drive>:\<PowerPath_pkg_name> /p /v"PPREMOVE=<feature1>, <feature2>, .. 
NO_REBOOT=1"

/r NOTE: Contact EMC customer support before using /r.

Use this option only when you encounter a problem with either installation or uninstallation of PowerPath.
This invokes the PPRemoveAll utility, which removes all PowerPath multipathing entries from the host.
This /r parameter replaces PPREMOVE=ALL.

NOTE: You do not need any of the above parameters with the /r parameter.

<Property> and <Value> descriptions

/L*v<logfile> Directs the Microsoft Installer to write verbose output to the file specified with this option. The
target directory for the log file must exist before starting a silent installation by using the logging
option (as required by the Windows installer engine). MSI logs are also available in %ProgramData%
\EMC\PowerPath\logs.

NOTE: These folders may be hidden in Windows Explorer.

ADDLOCAL=<fea
ture>

Where <feature> can be any combination of the following items. Use commas to separate multiple
entries, for example, ADDLOCAL=IBM,HDS
● If you do not pass ADDLOCAL values during command line installation, then PowerPath multipathing,

Migration Enabler, Management Component, and support for EMC storage arrays is installed by
default. If you pass ADDLOCAL values only the features you select are installed with PowerPath
multipathing.

● In the case of an upgrade, if you do not pass ADDLOCAL values during command line installation,
PowerPath installs the features based on the previous version configuration. For example, if your
previous version has Migration Enabler, HPXP, and IBM features installed then PowerPath upgrade
selects these features for installation by default.

● ALL = Complete installation. Installs support for all PowerPath features.
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● ME = Migration Enabler (selected for installation by default)

● HA = Management Component (selected for installation by default)

● IBM = IBM ESS and XIV arrays

● CELERRA = Celerra and VNXe arrays (selected for installation by default)

● HDS = Hitachi arrays

● HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS 4.0 or later

● INVISTA = Invista and VPLEX arrays (selected for installation by default)

● XTREMIO = XtremIO arrays firmware Version 2.2 or later (selected for installation by default)

● NETAPP = NetApp arrays (FAS2240)

● SC = Dell SC arrays

FORCE_DRIVER_
UPDATE=1

The value 1 continues to install PowerPath and ignores the device manager check for any pending device
installation or uninstallation activities.

IGNORE_HF_WAR
NING=1

The value 1 sets IGNORE_HF_WARNING value to ON and continues with the PowerPath installation even
if the required Microsoft Hotfixes on the target host are missing.

NOTE: This parameter will not ignore the SHA-2 KBs (3033929 and 2921916) in Windows Server

2008 R2 SP1 and SP2. Use NO_KBCHECK to ignore SHA-2 KBs.

INSTALLDIR=<p
ath>

Where <path> is the location to copy and install PowerPath files. For example, INSTALLDIR=C:\Test
and INSTALLDIR=C:\Program Files\EMC

NOTE: The default installation directory is <RootDrive>:\ProgramFiles\EMC.

LICENSENUM=<n
umber1,<[numb
er2,...]>

Where <number1,<[number2,...]> must be a valid license or no license will be saved. Use commas
to separate multiple entries.

NOTE: PowerPath for Windows and PowerPath/VE for Windows Hyper-V each require a separate

license. The licensing procedure is the same for each.

NO_KBCHECK=1 The value 1 ignores the SHA-2 KBs check in Windows Server 2008 R2 SP1 hosts.

NO_REBOOT=1 The value 1 specifies that the host will not reboot after PowerPath is installed or removed.

NOTE: Use NO_REBOOT=1 so that you can manually restart at a convenient time.

PERSIST_PATH_
INFO=1

● The value 1 sets PERSIST_PATH_INFO value to ON. The default is ON.

● The value 0 sets PERSIST_PATH_INFO value to OFF.

PPREMOVE=<fea
ture>

Specifies the features to uninstall. Use commas to separate multiple entries, for example:
PPREMOVE=ME, INVISTA

● CLEAN = Removes PowerPath and all other features, such as Migration Enabler. It also removes driver
files and corresponding registry entries.

● ME = Migration Enabler

● HA = Management Component

● IBM = IBM ESS and XIV arrays

● CELERRA = Celerra and VNXe arrays

● HDS = Hitachi arrays

● HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS 4.0 or later

● INVISTA = Invista and VPLEX devices

● XTREMIO = XtremIO arrays firmware Version 2.2 or later

● NETAPP = NetApp arrays

● SC = Dell SC arrays

PX_DELETE_CUS
TOM_CONFIGURA
TION=KEEP|
DELETE

The PowerPath installer provides an option to either keep or delete the existing powermt.custom file
through GUI or CLI methods. By default, the existing powermt.custom file is preserved.

● KEEP keeps the existing powermt.custom file

● DELETE deletes the existing powermt.custom file

For example, the CLI method provides the
parameter EMCPower.X64.signed.<version>.<build>.exe /s /
v"PX_DELETE_CUSTOM_CONFIGURATION=DELETE NO_REBOOT=1"
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UPGRADE_MPIO=
1

The value 1 specifies to upgrade the existing MPIO framework. Include this property if an MPIO version
earlier than the one supported is installed.

PowerPath installation aborts if the host has a version of the MPIO framework earlier than the supported
version.

USE_BINDING_O
RDER=1

The value 1 fixes incorrect IP address when performing auto host registration.

NOTE: When the next auto host registration is performed, the IP address of the first adapter in the

binding order list will be used.

XTREMIO_NATIV
E_ONLY=1

The value 1 specifies to install support for XtremIO Versions 2.2 and later for PowerPath Version 6.x.

This parameter is required in case of silent upgrade, when you are upgrading from PowerPath 5.7.1 with
generic XtremIO support installed to PowerPath 6.x, which supports only XtremIO Version 2.2 and later.
For example,

EMCPower.X64.signed.<version>.<build>.exe /s /v" XTREMIO_NATIVE_ONLY=1 
NO_REBOOT=1"
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Troubleshooting installation and upgrade
This appendix contains the following sections:

Topics:

• Troubleshooting PowerPath installation
• Repairing the PowerPath Installation
• Important Knowledge Base (KB) articles

Troubleshooting PowerPath installation
The following table lists PowerPath installation troubleshooting scenarios.

Table 6. Troubleshooting the installation 

Problem Error message Suggested action

PowerPath drivers may be present
on a host where a PowerPath
package has been uninstalled.

Incompatible files from
a previous PowerPath
version exist on the
host. PowerPath recommends
running PPRemoveAll with
a reboot and then
proceed with the PowerPath
installation process. Run
PPRemoveAll now?

Perform the following:
1. Click Yes to run PPRemoveAll.a. Otherwise,

click No and run the PPRemoveAll utility
manually.

2. Restart the host.
3. Install PowerPath.

Upgrade of PowerPath may fail
because PowerPath drivers are
missing on the host.

PowerPath detected a
problem that is blocking
the upgrade. Contact EMC
customer support for
assistance.

Perform the following:
1. Run the PPRemoveAll utility to remove

PowerPath.
2. Restart the host.
3. Install PowerPath.

NOTE: If the installation is still
blocked, contact your Customer Support
Representative.

Upgrade of a PowerPath driver may
fail.

The PowerPath upgrade
could not complete.
PowerPath recommends
running PPRemoveAll with
a reboot and then
proceed with the PowerPath
installation process. Run
PPRemoveAll now?

Perform the following:
1. Click Yes to run PPRemoveAll. Otherwise,

click No and run the PPRemoveAll utility
manually.

2. Restart the host.
3. Install PowerPath.

Installation of a PowerPath driver
may fail.

PowerPath encountered a
problem installing drivers
and will roll back
the installation changes.
Contact EMC Customer
Support for assistance.

Contact your Customer Support Representative.

One or more PowerPath drivers may
require a host restart.

One or more PowerPath
drivers require a host
reboot. Reboot the host
and then proceed with

Restart the host and then install PowerPath.

D
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Table 6. Troubleshooting the installation (continued)

Problem Error message Suggested action

the PowerPath installation
process.
One or more PowerPath
drivers require a host
reboot. Reboot the host,
and retry the repair.

Restart the host and then try the driver repair
again.

Repair of a PowerPath driver fails. The PowerPath repair
operation could not
complete. Contact EMC
customer support for
assistance.

Contact your Customer Support Representative.

PowerPath failed to enable MPIO. PowerPath installation
failed to enable MPIO
feature on Windows server
2008 or later host.

Contact your Customer Support Representative.

Installation of PowerPath for
Windows 6.1 or later, on Windows
Server 2008 R2 fails with the
following error:

PowerPath 6.1 or later
requires the following
Microsoft hotfixes to be
installed: KB2921916 and
KB3033929

Confirm if support for SHA256-signed drivers
exists on the server by trying to install both
of the KBs listed in the error message or
their superseded KBs. You can check Microsoft
Support for the superseded KBs. The installation
of the KBs should fail with errors indicating that
the KB is already installed or is not applicable.
Once SHA256 support is confirmed on the host,
bypass the PowerPath installer KB check by
passing NO_KBCHECK=1 installer argument while
installing using the CLI.

a. The PPRemoveAll utility removes all PowerPath multipathing entries from the host. Use this option only when you
encounter a problem with an existing installation or try a removal.

Repairing the PowerPath Installation
After installing PowerPath if any of the PowerPath functionality is broken, you can repair the installation to resolve those issues.
The repair re-installs PowerPath and modifies only those components of the application that are missing or broken. It also
re-installs all PowerPath drivers.

NOTE: Repairing PowerPath requires that you reboot the host.

Follow one of these procedures to repair PowerPath:

● Repair PowerPath installation using the GUI

● Repair PowerPath installation using the CLI

Repair PowerPath installation using the GUI

Perform one of the following steps to repair PowerPath installation through the GUI.

About this task

Alternatively, using Add/Remove Programs or Programs and Features, select the installed version of PowerPath and click
Repair.

Steps

1. Using Add/Remove Programs or Programs and Features, select the installed version of PowerPath and click Change.

a. In the Setup wizard welcome window, click Next.
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b. Select Repair.
c. Click Repair.
d. Click Finish.

2. Click Yes to reboot now or No to reboot later.

NOTE: If the User Account Control (UAC) is configured in the Admin Approval mode, running the PowerPath setup

program to change, repair, or to uninstall PowerPath 6.3 using Add/Remove Programs or Programs and Features

through the control panel results in multiple elevation prompts.

Repair PowerPath installation using the CLI

Steps

● Repair PowerPath.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> REINSTALL=ALL"
When NO_REBOOT=1 is used, reboot manually after installation.

For example,

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs\PPrepair.log 
REINSTALL=ALL NO_REBOOT=1"

Important Knowledge Base (KB) articles
Displays the list of Knowledge Base articles.

Table 7. Knowledge Base articles 

KB number Description KB link

502458 Windows PowerPath 6.1 prerequisite installation failed.
Installation cannot continue.

https://support.emc.com/kb/502458

500909 How to upgrade PowerPath from 5.7.x to 6.1 in Windows
Server 2008 and Windows Server 2012 environments

https://support.emc.com/kb/500909

500749 Running the command "powermig sync -handle X" or
"powermig cleanup -handle X" returns an error "PPME
error(79): Not all nodes have reached the correct state
to complete this operation, please try this or the recover
command again later"

https://support.emc.com/kb/500749

499452 How to uninstall Microsoft Visual C++ redistributables
installed by PowerPath

https://support.emc.com/kb/499452

495303 How to install PowerPath 6.1 via command line to avoid
verification of the installed Microsoft hotfix KBs 2921916
and 3033929.

https://support.emc.com/kb/495303

488109 What is the maximum number of luns that can be
presented, Maximum number of Paths per lun and
Maximum size of Partition on a Microsoft Windows
Operating System.

https://support.emc.com/kb/488109

486378 Disks are marked offline after upgrading to PowerPath 6.0 https://support.emc.com/kb/486378

473972 Unable to Install PowerPath. Prerequisite installation
failed. Installation cannot continue.

https://support.emc.com/kb/473972

466054 Different versions of PowerPath fail to install with error
"Setup encountered a problem while installing PowerPath.

https://support.emc.com/kb/466054
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Table 7. Knowledge Base articles (continued)

KB number Description KB link

PowerPath installation will be rolled back. Contact EMC
Customer Support for assistance."

460124 PowerPath: Errors "RPC Server is unavailable" during
Windows start-up and "Initialization Error" in response to
powermt command

https://support.emc.com/kb/460124

448058 PowerPath is not able to see devices in Windows Server
2008 or 2012. MPIO is also unable to see devices. How to
configure Native MPIO in Microsoft Windows Server 2008
and 2012.

https://support.emc.com/kb/448058

335250 Behaviour of PowerPath for Windows install, uninstall or
upgrade in a Boot from SANenvironment.

https://support.emc.com/kb/335250
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